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Introduction 
Overview 

  

 
Audia is a Digital Audio Platform, which provides distributed digital audio, signal processing, and control. 
 
Audia is a networkable, decentralized audio system, which is easy to configure & program. 
 
Audia allows the installer to quickly & accurately define the exact sound system required for each job. 
 
Audia is software programmable, easily expandable, and remotely controllable. 
 
Audia utilizes both CobraNet(TM) and Ethernet for enhanced system networking and control. 
 
Audia is a completely customizable, yet cost-effective, solution for sound system design. 
 
Audia is covered by a five-year warranty. 
 
 

 
ALGORITHMS 

• Mixers: standard, automatic, matrix, combiners 
• Equalizers: graphic & parametric 
• Filters: HPF, LPF, high shelving, low shelving 
• Crossovers: 2-way, 3-way, 4-way 
• Dynamics: levelers, comp/limiters, duckers, gates 
• Routers: 2x4 to 40x40 
• Delays: 0 to 2,000 mS 
• Controls: levels, mutes, presets, remotes, logic 
• Meters: signal present, peak reading, RMS reading 
• Generators: single tone, sweep, pink-noise, white-noise 
• Diagnostics: transfer function 
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HARDWARE: 
• Six 60 MHz 32-bit floating point Analog Devices SHARC DSPs (360 MFLOPS) 
• 80 MHz 32-bit Motorola Power PC host processor 
• 32 Mbytes SDRAM 
• 8 Mbytes Flash ROM 
• Ethernet communications for software control and configuration 
• Support of TCP/IP, UDP and ICMP (ping) networking standards 
• Battery backed real-time clock and calendar 
• Powered CAN bus for easy addition of AUDIA control devices; touch screens, rotary encoders, and contact 

switches 
• RS-232 serial port for simple connection to 3rd party control devices 
• Internal 80 watt universal switching power supply 
• Multiple analog I/O configurations (8x8, 4x12, & 12x4) 
• Mic/Line inputs with programmable mic preamp (0dB to ~ +66dB gain) 
• Optional CobraNet interface supporting 64 channels of digital audio (32 in/32 out) over Fast Ethernet 
• Compatible with all other CobraNet compliant devices 
• Works with standard Ethernet switches 
• Multiple system-wide presets and current settings stored in flash memory 
• Layout drawing information stored in flash memory 
• 24-bit A/D & D/A converters 
 
 
 
 
SOFTWARE: 

• Win32 application - Windows NT 4.0/2000/XP operating system required 
• Fully dockable Menu and Toolbar support 
• Birdseye viewer for easy panning and zooming of large layout files 
• Fully customizable Processing Library bar for storing default and custom DSP objects 
• Workspace state saved at program shutdown, including current documents, Toolbar, Catalog & Birdseye viewer 

states 
• User configurable data file and Processing Library catalog 
• Simple object attribute control: colors, line widths, hatching, text font, size, style & alignment, border widths, etc. 
• Multiple simultaneous line (wire) drawing with no special editing modes required 
• Special text block object to enter freeform text and label information 
• Easy-to-use tools for object alignment, sizing, packing, spacing & centering 
• Fully supported object drag-and-drop between Catalog and view, and between views 
• Fully supported multiple layers within a drawing 
• Support of Clipboard operation 
• Programmable presets 
• Export file types: DXF (drawing interchange format) & EMF (enhanced meta files) 
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Architect’s & Engineer’s Specification 

 
AUDIA(TM) Digital Audio Platform 
 
ARCHITECTS & ENGINEERS SPECIFICATION  (January 1, 2002) 
 
The Digital Audio Platform shall be available in three hardware configurations: 
8-in/8-out (8x8); 12-in/4-out (12x4); and 4-in/12-out (4x12).  Inputs and 
outputs shall be analog, with internal 24-bit A/D & D/A converters operating at 
a sample rate of 48kHz.  All internal processing shall be digital (DSP).  
Electronically balanced inputs and outputs shall be provided on plug-in barrier-
strip connectors.  Inputs shall be individually programmable to accept either 
microphone or line level signals.  The 12x4 configuration shall allow inputs 11 
& 12 to be set for mono summing of unbalanced stereo line level signals.  
Outputs shall normally provide line level signals, however, the 4x12 
configuration shall allow outputs 1~4 to be individually programmed to provide 
microphone level signals. 
 
Each hardware configuration shall include six 60MHz 32-bit floating point SHARC 
DSPs, an 80MHz 32-bit Power PC host processor, 32MB SDRAM, and 8MB Flash ROM.  
Software shall be provided for creating/connecting DSP system components within 
each hardware unit.  Available system components shall include (but not be 
limited to) various forms of: mixers, equalizers, filters, crossovers, 
dynamics/gain controls, routers, delays, level controls, level meters, and tone 
generators.  Ethernet communications shall be utilized for software control, 
configuration, and DSP sharing.  CobraNet(TM) technology shall transport digital 
audio over fast Ethernet, allowing multiple units to share digital audio.  After 
initial programming, systems may be controlled using either TCP/IP or RS-232 
serial communication by third party control systems such as AMX(TM) and 
Crestron(TM). 
 
Each hardware configuration shall be available with CobraNet(TM) (for multi-unit 
network applications) or without CobraNet(TM) (for stand-alone applications).  
Multi-unit network applications require an external 10/100Base-T Ethernet 
switch.  All CobraNet(TM) & Ethernet connections shall be via CAT5 cable or 
fiber-optic.  Software shall operate on a PC computer, with network card 
installed, running Windows(TM) NT 4.0/2000/XP. 
 
The Digital Audio Platform shall be AUDIA. 

 

 

 

 

 

 

Documentation 

The information contained in this Help file can be printed in manual form (with Table of Contents and Index).  Two 
PDF documents are provided on the software CD-ROM for this purpose.  The file AUDIA.pdf is intended for printing 
on Letter (8.5" x 11") size paper.  The file AUDIA-A4.pdf is intended for printing on A4 (210mm x 297mm) size 
paper.  These are printable Help files.  Similar PDF files are also available on the software CD-ROM, for the ’RS-232 & 
Telnet Protocol’ and the ’Quick Start Guide & Safety Information’ documents. 
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Software Tools 
Basic Screen Elements 

The main screen of the Audia(TM) software has several sections.  The Layout occupies the largest portion of the main 
screen, at the lower-right.  This is the area where system design actually occurs, with the placement & connection of 
Component Objects.  Component Objects represent the individual audio devices (processing blocks) within the 
system.  Other objects include Lines (for connecting components) and Text (for labeling the system).  If a system 
becomes too big to fit the Layout, a Bird’s Eye View is available to aid navigation.  A Processing Library of available 
Component Objects is displayed, at the lower-left of the main screen, for drag & drop placement into the Layout.  
However, the Processing Library can be closed, increasing the width of the Layout, and Component Object selection 
can then be accomplished using the Object Toolbar, located directly above the Layout.  The Object Toolbar also 
provides the option of either a select or a text cursor.  Above the Object Toolbar is the Format Toolbar, which allows 
customizing of text & colors used in the Layout and associated objects.  Above the Format Toolbar is the Layout 
Toolbar, which affects certain aspects of Layout, such as the grid, rulers, zooming, & alignment of Component 
Objects.  The Layout Toolbar can also open editing/information sheets for properties, objects, & layers.  Above the 
Layout Toolbar is the Network Toolbar, with functions related to communications, configuration, maintenance, and 
testing of the system network.  Above the Network Toolbar is the Standard Toolbar, with file functions such as new, 
open, & save, plus additional functions such as cut, copy, paste, print, & help.  The Standard Toolbar also includes 
the Compile function, which will generate a new configuration file, while checking system layout/connections & 
determining DSP resource allocation.  Above the Standard Toolbar are the Main Menus, which provides all of the 
toolbar functions mentioned above, with several more in-depth editing functions.  Along the bottom edge of the main 
screen is a Status Bar, which gives indication of object quantity, location, & size, as well as layer name, visability, & 
locking.  The location and shape of all toolbars, including the Processing Library, may be changed to fit the user’s 
preference. 
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Layout 

  

The Layout occupies the largest portion of the main screen, at the lower-right.  This is the area where system design 
actually occurs, with the placement & connection of Component Objects.  Component Objects represent the individual 
audio devices (processing blocks) within the system.  Other objects include Lines (for connecting components) and 
Text (for labeling the system).  Component objects can be placed into the Layout from the Processing Library, the 
Object Toolbar, or the Processing Library Menu.  The Layout has fixed dimensions of 16384x16384 pixels (approx. 
163.75" square).  Therefore, horizontal & vertical scroll bars are used to navigate within the Layout.  Zoom In/Out and 
a Bird’s Eye View are also available as navigational aids, and can be accessed from the Layout Toolbar or View Menu.  
The Ruler and Grid may be turned on/off from the Layout Toolbar, and the background color of the Layout may be 
changed from the Format Toolbar.  Grid Settings, such as snap-to-grid, grid spacing, and guideline spacing, are 
available from the Layout Menu.  Minimize, Down-Size, and Close buttons for the Layout are located in the upper-
right corner of the main screen.  Right-clicking over the Layout provides a pop-up menu of options. 
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Bird’s Eye View 

  

The Bird’s Eye View provides a thumb-nail sketch of the entire system 
design, to aid navigation within the Layout.  Bird’s Eye View initially 
covers an area of only 8" x 5", but will automatically increase size to cover 
a larger system design.  A black rectangle frames the viewable area.  The 
rectangle may be dragged to view any location within the system design.  
The rectagle also has handles to re-size the viewable area, from a 
minimum of 4" x 2.5" to a maximum of 16" x 10". 

 

 

Processing Library 

  

A Processing Library of available Component Objects is displayed, at the 
lower-left of the main screen.  The Component Objects are organized in 
twelve categories:  Input Output; Mixers; Equalizers; Filters; Crossovers; 
Dynamics; Routers; Delays; Controls; Meters;  Generators; and 
Diagnostics. 

 

Once a category is selected, the pre-defined components available from that 
category will be displayed underneath the category heading.  A vertical 
scroll bar will appear on the right if the available components cannot all be 
displayed.  To place a Component Object, simply drag & drop it into the 
Layout at the desired location.  Customized and grouped components may 
be added to the Processing Library (see Customizing Component Objects). 

 

The Processing Library may be closed, thereby increasing the width of the 
Layout, and components can instead be selected from the Object Toolbar.  
The Object Toolbar also allows configuration of some components, as they 
are placed into the Layout. 

 

To close the Processing Library, left-click on the ’X’ in the upper-right 
corner.  The Processing Library can again be opened by selecting any 
component category from the Process Library Menu.  The Processing 
Library can also be opened/closed from the View Menu. 

 

Right-clicking over the Processing Library provides a pop-up menu of 
options.  The location and shape of all toolbars, including the Processing 
Library, may be changed to fit the user’s preference. 
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Object Toolbar 

  

The Object Toolbar, located directly above the Layout, allows Component Object selection for placement into the 
Layout.  The Component Objects are organized in twelve categories: Input Output; Mixers; Equalizers; Filters; 
Crossovers; Dynamics; Routers; Delays; Controls; Meters;  Generators; and Diagnostics. 

Each category is represented by an icon, with a drop-down menu to the right.  To place a Component Object, first 
choose the appropriate category, then select the desired component from the drop-down menu.  Once the component 
has been selected, simply left-click at the desired location on the Layout.  Left-clicking a category icon will select the 
component which occurs first in the menu list.  When using the Object Toolbar to place components into the Layout, 
certain components will present the user with a pop-up window of configuration options. 

The Object Toolbar also provides the option of either a select cursor or a text cursor.  The select cursor is for 
component selection, placement, wiring, etc.  The text cursor is for placing Text Objects into the Layout, for system 
design labeling purposes. 

When using the Object Toolbar, the Processing Library may be closed, increasing the width of the Layout.  The Object 
Toolbar may be opened/closed from the View Menu.  The location and shape of all toolbars may be changed to fit the 
user’s preference. 

 

 

Format Toolbar 

  

The Format Toolbar allows customization of text & colors used in the Layout and associated Component, Line, & 
Text Objects.  The available tools are:  Font;   Size;  Bold;  Italics;  Align Left;  Center;  Align Right;  Back Color;  
Text Color;  Fore Color;  Hilite Color;  Pen Width;  and  Hatch Style.  The Format Toolbar may be opened/closed 
from the View Menu.  The location and shape of all toolbars may be changed to fit the user’s preference. 

 

Tools 
 

Font 

  

Provides a drop-down menu of lettering styles 

for use in Component or Text Objects. 

 

Size 

  

Provides a drop-down menu of lettering sizes 

for use in Component or Text Objects. 
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Bold 

  

Changes the selected text to a thicker 

version of the chosen font. 

 

Italic 

  

Changes the selected text to an italicized 

version of the chosen font. 

 

Align Left 

  

Aligns the selected text to the left margin 

of the Component or Text Object. 

 

Center 

  

Centers the selected text between the left and 

right margins of the Component or Text Object. 

 

Align Right 

  

Aligns the selected text to the right margin 

of the Component or Text Object. 
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Back Color 

  

Provides a drop-down menu for changing the background 

color of the Layout, or of selected Component or Text Objects.  

 

Left-clicking the icon applies the color which was selected last. 

 

Text Color 

  

Provides a drop-down menu for changing the text color 

in selected Component or Text Objects. 

 

Left-clicking the icon applies the color which was selected last. 

 

Fore Color 

  

Provides a drop-down menu for changing the color of the lower 

and right borders, as well as any internal Hatching, of the 

selected Component, Line, or Text Objects. 

 

Left-clicking the icon applies the color which was selected last. 

 

Hilite Color 

  

Provides a drop-down menu for changing the color of the upper 

and left borders of the selected Component or Text Objects. 

 

Left-clicking the icon applies the color which was selected last. 
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Pen Width 

  

Provides a drop-down menu for changing the width of line used 

for the borders of the selected Component, Line, or Text Objects. 

 

Left-clicking the icon applies the width which was selected last. 

 

Hatch Style 

  

Provides a drop-down menu for changing the hatching 

style within the selected Component or Text Objects. 

 

Left-clicking the icon applies the style which was selected last. 
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Layout Toolbar 

  

The Layout Toolbar affects certain aspects of Layout, such as the grid, rulers, zooming, & alignment of Component 
Objects.  The Layout Toolbar can also open editing/information sheets for properties, objects, & layers.  The available 
tools are:  Property Sheet;  Object Inspector;  Layers Sheet;  Toggle Grid;  Toggle Ruler;  Bird’s Eye View;  Zoom In;  
Zoom Out;  Zoom 1:1;  Zoom Level;  Pack Objects;  Align Edges;  Center In View;  Space;  Make Same Size;  and To 
Front Or Back.  The Layout Toolbar may be opened/closed from the View Menu.  The location and shape of all 
toolbars may be changed to fit the user’s preference. 

 

Tools 
 

Property Sheet 

  

Provides an editable table of attributes regarding the 

Layout and its associated objects.  Only Display Attributes 

are shown for the Layout (and Lines).  Both Display and 

DSP Attributes are shown for Component Objects. 

 see Layout Property Sheet 

 see Line Property Sheet 

 see Object Property Sheet 
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Layout Property Sheet 

  

Provides an editable table of attributes regarding the 
Layout.  Only Display Attributes are shown for the 
Layout.  Most Display Attributes duplicate 
functions found in the Format Toolbar  However, 
some exceptions are as follows: 

 

PrintScale is entered as decimal information, where 
0.5 = 50% or 2.0 = 200%.  ViewLayers opens the 
Layers Sheet.  Tag is for user comments or other 
identifying text. 

 

The thumb-tack (upper-left) allows the Property 
Sheet to remain open while selecting other objects.  
1By1 (upper-right) allows any group of selected 
components (multi-selection) to appear on the 
menu. 

 

 

Line Property Sheet 

  

Only Display Attributes are shown for Lines 
(component connections).  Most Display Attributes 
duplicate functions found in the Format Toolbar.  
However, some exceptions are as follows: 

 

Object Code is a non-editable indentifier.  Layer 
determines which layer the Line is assigned to.  Tag 
is for user comments or other identifying text. 

 

The thumb-tack (upper-left) allows the Property 
Sheet to remain open while selecting other objects.  
1By1 (upper-right) allows any group of selected 
components (multi-selection) to appear on the 
menu. 
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Object Property Sheet 

  

 

  

Both Display and DSP Attributes are shown for 
component objects. 

 

Most Display Attributes duplicate functions found 
in the Format Toolbar.  However, some exceptions 
are as follows: 

 

Object Code is a non-editable indentifier.  Left, 
Top, Width, & Height specify object location and 
size (in pixels).  Layer determines which layer the 
component is assigned to.  Tag is for user 
comments or other identifying text. 

 

Most DSP Attributes duplicate functions found in 
the individual component Control Dialog boxes (see 
Component Object Properties).  However, some 
exceptions are as follows: 

 

Allocated To Unit assigns the component (DSP 
block) to a particular unit in the system.  Allocated 
To Gang assigns multiple components (DSP 
blocks) to a common ’gang’, forcing them to be 
grouped into the same unit.  Fixed In Unit prevents 
changes to Allocated To Unit and Allocated To 
Gang.  Instance ID is the system-wide identifier 
number for the component (DSP block).  Password 
Level selects either Designer or Technician access 
level, for individual components.  Delay 
Equalization turns on/off compensation for 
propagation delay (Input Output components only).  
See System Compiling Considerations. 

 

The thumb-tack (upper-left) allows the Property 
Sheet to remain open while selecting other objects.  
1By1 (upper-right) allows any group of selected 
components (multi-selection) to appear on the 
menu. 
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Object Inspector 

  

Provides a list of all objects within the Layout, along with their Object Codes, 

Text Labels, Unit numbers, and Instance ID numbers. 

  

 

 

Layers Sheet 

  

Provides an editable table of Layer properties.  Layers can be used 
to separate a Layout into multiple parts.  The Layers can be 
organized with regards to object types, system segments, or any 
other criteria.  The Default Layer always remains, but other Layers 
may be created or removed, using Add & Delete.  Layers may be 
selected directly from the list.  Up & Down change the position of 
a Layer in the list only (Layers are not stacked, so this does not 
affect Tab Order or visual overlapping).  All objects in a given 
Layer can be selected with Select.  Added Layers can be given a 
custom Name.  View turns on/off visibility of a Layer in the 
Layout.  NOTE:  Components cannot be selected  when the 
current Layer is invisible.  Lock prevents a Layer from being 
changed or selected.  Lock & View may also be accessed by 
double-clicking on the corresponding icons within the list. 
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Toggle Grid 

  

Turns Layout Grid on/off. 

 

Toggle Ruler 

  

Turns Layout Ruler on/off. 

 

Bird’s Eye View 

  

Turns Bird’s Eye View on/off. 

 

Zoom In 

  

Increases magnification of Layout in 25% increments. 

 

Zoom Out 

  

Decreases magnification of Layout in 25% increments. 

 

Zoom 1:1 

  

Returns magnification of Layout to 100%. 

 

Zoom Level 

  

Provides a drop-down menu of available Zoom 

magnifications (50% ~ 200% in 25% increments). 
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Pack Objects 

  

Provides a drop-down menu for packing selected objects next 

to each other.  The target location for packing left/right is the top 

most selected object.  The target location for packing top/bottom 

is the left most selected object. 

  

Left-clicking the icon applies the packing which was selected last. 

 

Align Edges 

  

Provides a drop-down menu for aligning the edges of selected 

objects.  The primary selected object (green handles) provides 

the target edges for alignment. 

  

Left-clicking the icon applies the alignment which was selected last. 

 

Center In View 

  

Provides a drop-down menu for centering the Layout view on the 

selected objects. 

  

Left-clicking the icon applies the centering which was selected last. 
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Space 

  

Provides a drop-down menu for evenly spacing selected objects.  Spacing 

is determined between the two most distantly spaced selected objects. 

  

Left-clicking the icon applies the spacing which was selected last. 

 

Make Same Size 

  

Provides a drop-down menu for matching the dimensions of selected 

objects.  The primary selected object (green handles) provides the target 

dimensions.  Objects cannot be smaller than original size. 

  

Left-clicking the icon applies the sizing which was selected last. 

 

To Front Or Back 

  

Provides a drop-down menu for changing the order in which overlapping 

objects appear on the Layout.  The selected object(s) will either move in 

front of overlying objects, or will move behind underlying objects. 

  

Left-clicking the icon applies the direction which was selected last. 
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Network Toolbar 

  

The Network Toolbar provides functions related to communications, configuration, maintenance, and testing of the 
system network (see System Network Considerations). 

Network Toolbar function includes:  Connect;  Disconnect;  Connect To System;  Disconnect From 
System;  Send Configuration;  Sync Data;  Start Audio;  Stop Audio;  and Device Maintenance.     

 

Tools 
 

Connect 

  

Establishes communication with, and provides a list of, 

all Audia(TM) devices on the network. Opens System Connect 

dialog box (see System Network Considerations). 

No system design data is transmitted or retrieved. 

 

Disconnect 

  

Ends communications with all Audia(TM) devices on the network. 

See System Network Considerations. 

 

Connect To System 

  

Establishes communication with, and retrieves data from, selected 

Audia(TM) systems on the network.  Opens System Connect dialog 

box (see System Network Considerations).  Password protection is 

then available from the Tools Menu.  When connected to a system, 

Component Object Properties may be changed, but system design 

(objects & connections) cannot. 
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Disconnect From System 

  

Ends communications with selected Audia(TM) systems on the 

network.  See System Network Considerations.  System design 

data is retained in software after disconnect. 

 

Send Configuration 

  

Transmits system design data to selected Audia(TM) devices in the 

system.  See System Network Considerations.  Before data can be 

transmitted, a system design file (.DAP) must first be opened, 

connected to a system, and have Audia(TM) device IP addresses assigned 

(see Tools Menu and Device Maintenance).  Send Configuration will 

automatically Compile the system design, and reset the hardware 

devices, before sending the new configuration.  

 

Sync Data 

 

Re-synchronizes the software with the 

connected Audia(TM) devices in the system. 

 

Start Audio 

  

Enables audio signal flow within the selected system.  See 

System Network Considerations.  Start Audio is available 

only after Send Configuration has been successfully performed. 
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Stop Audio 

  

Disables audio signal flow within the selected system. 

See System Network Considerations. 

 

Device Maintenance 

  

Provides an editable table of network related settings for selected Audia(TM) 

devices.  Opens Device Maintenance dialog box.  Device Maintenance settings 

include Date/Time, IP Adress, Description, Serial Number, Reset/Initialize, 

Update Firmware, and Disconnect From Network.  (See System Network Considerations.) 
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Device Maintenance Dialog Box 

  

Device Information provides information (such as firmware version, input/output configuration, etc.) regarding the 
selected device.  Set Date/Time allows update of the internal real-time clock.  Set IP Address assigns the device IP 
Address as 192.168.1.X (where range of X = 1~254).  IP Address cannot be duplicated, even in simple (Audia only) 
networks, and must be carefully managed when network topology is more complex.  Set Device Description allows the 
selected device to be given a descriptive name.  Serial Port Setting determines the baud rate of RS-232 
communications (currently fixed at 38,400).  Reset/Initialize clears all current system design data from the selected 
device.  This happens automatically whenever a new system design file (.DAP) is uploaded (see Send Configuration).  
Update Firmware uploads flash update files (.JAM) to the selected device. 

RCB Devices opens a list of devices connected to the Remote Control Bus of the selected Audia device.  Identify 
Device causes indicators on the selected device to flash (for physical location).  Set Device Description allows the 
selected device be given a custom name.  Update Firmware allows future firmware updates to be loaded into the 
selected device.  The information in this list (including Serial #) is used to establish proper association between the 
external physical controls and their corresponding component counterparts in the layout (see Equipment Table).  
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Standard Toolbar 

  

The Standard Toolbar provides file functions such as  New,  Open, &  Save, plus additional functions such as  Cut,  
Copy,  Paste,  Undo,  Redo,  Print, &  Help.  The Standard Toolbar also includes the Compile function, which will 
generate a new configuration file, while checking system layout/connections & determining DSP resource allocation.  
See File Menu and Edit Menu for more options. 

 

Tools 
 

New 

  

Begins a new Audia(TM) system design file (.DAP). 

 

Open 

  

Opens an existing Audia(TM) system design file (.DAP). 

 

Save 

  

Saves the current Audia(TM) system design file (.DAP). 

 

Compile 

  

Provides system design analysis and calculates DSP processing requirements.  

Makes initial determinations of quantity/type of Audia(TM) devices needed, 

CobraNet(TM) channel assignments, and allocation of DSP resources.  Also 

provides indication of system design errors.  See System Compiling Considerations.   
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Cut 

  

Removes the selected object(s) from the 

Layout, and places them in the Clipboard. 

 

Copy 

  

Places a copy of the selected 

object(s) into the Clipboard. 

 

Paste 

  

Places a copy of the object(s) from 

the Clipboard into the Layout. 

 

Undo 

  

Will undo last operation. 

 

Redo 

  

Will redo most recent Undo operation. 

 

Print 

  

Opens a print dialog box, to adjust 

printer settings and print the Layout. 

 

 



 28 

Main Menus 

  

The Main Menus provide most of the toolbar functions mentioned previously, in Basic Sceen Elements, as well as 
several more in-depth functions.  Main Menus includes the following individual menus: File; Edit; View; Processing 
Library; Presets; Tools; Layout; Window; and Help.  Keyboard shortcuts are shown on the menus, where applicable. 

 

File Menu 

 

Export 

Allows the Audia(TM) Layout to be exported in different file formats.  

DXF & Enhanced DXF formats are for use with CAD programs. 

EMF (Enhanced MetaFile) is for insertion as a picture into 

documents such as Word & PowerPoint.  DSP Data to Text 

provides signal processing data in Text file format. 

  

 

Close 

Closes and saves the current Audia(TM) system design file. 

 

Save As 

Saves the current Audia(TM) system design file (.DAP), 

with choice of directory location and file name. 
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Network 

Most Network Menu items duplicate functions found in the 

Network Toolbar, except for Send Control Dialog Layout Information, 

which allows open (or minimized) control dialog box settings to be 

updated/saved to the hardware device. 

See Component Object Properties and Software User Interface. 

   

 

Print Preview 

Previews printing results based on Print Setup. 

 

Print Setup 

Opens a print dialog box to adjust printer settings. 

 

Recent File 

Provides a list of recently saved files for convenient access. 

 

Exit 

Closes the Audia(TM) software program. 

Also provides prompt to save the current 

Audia system design file if necessary. 

If a file is open during Exit, that file will 

automatically open at next session. 
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Edit Menu 

 

Copy DSP Data 

Places a copy of the DSP data from the selected object 

into the Clipboard.  DSP Data represents the current settings 

of that Component Object.  See Component Object Properties. 

DSP Data can be copied from only one Component Object at a time. 

 

Paste DSP Data 

Places a copy of the DSP data from the Clipboard into the 

selected Component Object.  DSP Data represents the current 

settings of that Component Object.  See Component Object Properties. 

DSP Data can be pasted into multiple Component Objects, as long as 

they are all of the identical configuration as the original. 

 

Duplicate 

Places a copy of the selected Component or Text Object directly 

into the Layout.  Duplicate also places a copy of the object into the 

Clipboard.  Duplicate works with only one object at a time. 

 

Select All 

Provides an easy way to select all objects on the Layout. 

Also allows all objects of a specific type to be selected. 

  

 

Delete 

Removes the selected object(s) from the Layout, 

without placing a copy into the Clipboard. 
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Control Dialog 

Opens a Control Dialog box for the selected Component Object. 

Control Dialog boxes provide a graphic means of displaying and 

adjusting Component Object settings.  See Component Object Properties. 

 

View Menu 

Toolbars provides a drop-down menu to turn on/off any of the toolbars 

(see Basic Screen Elements).  Staus Bar, Ruler Bars, Zoom, & Bird’s Eye Viewer 

select those functions, as found on the Layout Toolbar. 

  

 

 

Processing Library Menu 

Provides a list of Component Object categories from the 

Processing Library.  When a category is selected from the menu, 

the Processing Library opens to that category automatically. 
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Presets Menu 

 

Create/Edit/Recall 

Provides the Create/Edit Preset dialog box, for creating, editing, saving, and recalling presets.  Each preset can have a 
custom Preset Name, and will automatically be assigned a Preset ID number.  A check-box is provided to assign the 
selected preset to be Set As Power-Up Default.  This preset will automatically be recalled each time the system is 
powered up.  A check-box is also provided to assign the selected preset to Mute Audio During Recall.  If audio is not 
muted during recall, some processing noises may be audible.  Component Objects (DSP Blocks) may be selected, and 
added or removed from any preset using the Add Sel, Add All, Rem Sel, and Rem All buttons.  Therefore, presets may 
be customized to affect Component Objects individually, in groups, or as an entire system.  Initially, all Component 
Objects in the Layout will be selected (included in the preset).  Individually selected components become highlighted in 
the layout.  Right-clicking the selected component allows it to be located in the layout and its control dialog to be 
opened.  These features make it easy to change individual component settings within the preset being created/edited.    

  

A tab at the upper-right of the Create/Edit Preset dialog box provides additional 
functions.  Next ID and Prev ID allow selection from a list of existing presets.  Recall 
retrieves all settings stored in the selected preset.  New selects the next available Preset 
ID, for creation of a new preset.  Save will over-write the selected Preset ID with all 
changes, including Preset Name.  Save As will write changes into the next available 
Preset ID.  Delete will remove the selected preset from memory.  Send will send all 
saved presets to the Audia devices in the system.  NOTE:  Be sure to use Recall before 
attempting to edit an existing preset.  Otherwise, the preset could be over-written with 
settings from a previous preset, and any settings made since it was recalled. 

A tab at the lower-left of the Create/Edit Preset dialog box provides a list of existing 
presets.  Left-clicking selects a preset.  Double-clicking recalls a preset (as indicated 
by a green arrow to the left). 
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Recall 

Provides the Recall Preset dialog box, for recalling existing presets.  Recall Preset will retrieve all settings stored in 
the selected preset.  Presets can also be recalled using components called Preset Buttons and Remote Preset Buttons, 
which can be placed into the Layout from Controls on the Object Toolbar.  

  

 

 

 

Tools Menu 

 

Passwords 

Provides the Set Passwords dialog box, for establishing password protection in selected Audia(TM) devices.  Set 
Password allows up to four levels of protection, each with a unique password (6~16 characters).  Designer level 
allows access to system configuration, component settings, storing/recalling presets, and password assignments.  
Technician level limits access to component settings and storing/recalling presets.  User level limits access to 
recalling presets only.  However, Level Control and Meter dialog boxes can be minimized for User access (see 
Customizing Component Objects).  Guest level limits access strictly to connection and viewing only. 

  

NOTE:  You must first Send Configuration to a device before a Password can be assigned.  Passwords cannot be 
assigned to non-configured devices or design layouts.  
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Equipment Table 

Provides an editable table of Audia(TM) devices in the system design.  Devices may be manually added or removed 
from the design.  However, Compile will add devices if needed (but will not automatically remove unnecessary 
devices).  The Equipment Table may be used to aid system design, by initially specifying desired hardware 
configurations.  Serial # and Device Description Label appear only when connected to a system, at which time the 
Equipment Table becomes ’read-only’ information. 

  

A tab at the lower-left of the Equipment Table dialog box provides an editable table of devices connected to the 
Remote Control Bus of the Audia devices in the system design.  This table is used to establish proper association 
between external physical controls and their corresponding component counterparts in the layout.  Each DevID 
(control component) should be matched to an appropriate Serial # (physical control).  The DevID number can be 
found in the right corner of control component objects in the layout, when ’Display Device Assignment in DSP Block 
Info Field’ is selected from Display Options.  Serial # and Device Description information can be found for the 
physical controls using Device Maintenance.  
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Layout Compile Results 

Provides the most recent Compile results.  This information may be viewed at any time. 

  

 

 

Signal Path Indentifier 

Provides a temporary color-coded identification of all signal paths (Lines) which are associated with a selected Line 
Object.  See example below, where the selected input is shown as being routed to four outputs.  Signal Path Indentifier 
is represented by a thin dashed red line.  However, the Signal Path Indentifier color may be changed in Display 
Options.    

  

 

 

Options 

Allows global options to be selected, which affect software behavior.  An Options dialog box appears, with three tabs:  
General;  Display;  and Compile. 

 see General Options 

 see Display Options 

 see Compile Options 
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General Options 

Allows Data Files (system designs) and Processing Libraries (Component Objects) to be saved to specified directory 
locations.  Allows Save AutoRecover time to be adjusted or disabled.  Allows most recent Component Object 
selection to be retained, for repeated placement into Layout.  Allows Compressed File Format to be disabled.  Allows 
Meter activity to be disabled (locked), to reduce network data traffic. 

  

 

Display Options 

Allows DSP Blocks (Component Objects) to display Device Assignment or Group Assignment numbers, as 
determined by Compile.  (Device Assignments can be changed in the Property Sheet.)  Allows color of Signal Path 
Identifier to be changed.  Allows CobraNet(TM) Connections to be displayed, and color to be changed (see System 
Network Considerations).  Alows the default Grid to be applied when starting new design files.    
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Compile Options 

Allows Auto Device Add to be disabled, or Audia(TM) device type preference to be specified (guides Compile function 
in determining hardware requirements).  See System Compiling Considerations.  Allows Delay Equalization to be 
disabled system-wide (see System Compiling Considerations).  Allows automatic re-assignment of Instance IDs 
during Compile or Send Configuration.  Allows Compile function to be stopped if warning occurs.  Allows Device 
Assignments to be excluded from Paste DSP Data. 

  

 

 

 

Layout Menu 

Most Layout Menu items duplicate functions found in the 

Layout Toolbar.  However, some exceptions are as follows: 

Align Objects;  Order;  Objects;  and Grid Settings. 
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Align Objects 

  

Align Objects provides Vertical Center & 

Horizontal Center functions, in addition to the 

Align Edges functions found on the Layout Toolbar. 

 

Order 

 

Order provides Bring Forward & Send Backward 

functions, in addition to the To Front Or Back 

functions found on the Layout Toolbar. 

 

Object Sheet 

  

Provides a list of all objects within the Layout. Normally, 
objects can be selected sequentially using the Tab key.  The 
Object Sheet allows the order of this Tab selection to be 
changed. Objects may be selected directly from the list. When 
an object is selected, Up and Down change the Tab Order 
position of that object. 

 

Grid Settings 

  

Grid Settings allows the Layout Grid to be customized.  
Show Grid turns the Grid on/off.  Snap To Grid forces 
the upper-left corner of objects to align with grid-marks.  
Snap To Center forces objects to center around grid-
marks.  Spacing determines the space between grid-
marks (in pixels).  Guidelines changes the location (in 
pixels) of the blue, dotted guidelines (initially found near 
the edges of the Layout). 
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Window Menu 

Multiple Layouts (system design files) may be open at the same 

time. Only one Layout will be active at a time (as indicated by the title bar). 

Layouts can be arranged on the display using the Window Menu. 

Cascade overlays the Layouts in an hierarchy.  Tile fits the Layouts within 

the display. Close will close the active Layout.  Close All will close all Layouts. 

A list of open Layouts is provided for selection. 

  

 

 

 

Help Menu 

Provides Audia(TM) Help Topics and About Audia information. 

  

 

 

 

Status Bar 

  

The Status Bar, along the bottom of the main screen, provides system information.  The left side of the Status Bar 
(shown above) indicates system status, tool tips, or flash update information   The right side of the Status Bar (shown 
below) indicates system/network connection status (with progress bar), total number of objects, number of objects 
selected, Layer status, object location, and object size. 
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Component Objects 

 

Input Output 

  

These Component Objects provide the analog audio input/output (I/O) to the system.  CobraNet(TM) Input/Output 
components are also available, allowing system designs to include third-party A/D & D/A converters which have 
CobraNet capability.  Input Output components are available in pre-defined configurations, however, the configuration 
may be customized when being placed from the Object Toolbar. 

Once a Component Object is placed into the Layout, all available settings can be accessed by double-clicking over the 
object.  This produces a Control Dialog Box, which displays the component controls in a more conventional user 
interface. 

 see Input Control Dialog 

 see Output Control Dialog 

 see CobraNet Input Control Dialog 

 see CobraNet Output Control Dialog 

Right-clicking over the object provides a pop-up menu of options. 

 

Control Dialog 
 

Input Control Dialog 

  

Device IO indicates which hardware input is 
associated with that software channel.  Gain 
In compensates for different input signal 
levels, and should be set so Peak In flashes 
only occasionally (6dB headroom).  Phan 
Pwr assigns +48 Volt phantom power to the 
input for condenser microphones.  Mute In 
turns the input signal on/off.  Level In adjusts 
the relative input volume.  Invert In reverses 
polarity (phase) of the input signal. 

 

Right-clicking over certain settings will 
provide a menu of additional options. 
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Output Control Dialog 

  

Device IO indicates which hardware output is associated with that software 
channel.  Mute Out turns the output signal on/off.  Level Out adjusts the 
relative output volume.  Invert Out reverses polarity (phase) of the output 
signal. 

 

Right-clicking over certain settings will provide a menu of additional 
options. 

 

 

CobraNet Input Control Dialog 

  

Adjust external signal source so Peak In flashes only occasionally (6dB 
headroom).  Mute In turns the input signal on/off.  Level In adjusts the 
relative input volume.  Invert In reverses polarity (phase) of the input 
signal. 

 

CobraNet Bundle assigns digital audio data to a particular bundle number.  
CobraNet Bundle Numbers are used to match those of any third-party 
CobraNet A/D converters being used in the system.  Normally, ’unicast’ 
bundles 256 ~ 61,439 are selectable.  These are device specific bundles (for 
exchange of digital audio with only one other device).    Multicast allows 
selection of bundles 1 ~ 255, which are not device specific (for exchange of 
digital audio with multiple devices).  Enable turns on/off the exchange of 
CobraNet digital audio data from this device. 

 

Right-clicking over certain settings will provide a menu of additional 
options. 
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CobraNet Output Control Dialog 

  

Mute Out turns the output signal on/off.  Level Out adjusts the relative output 
volume.  Invert Out reverses polarity (phase) of the output signal. 

 

CobraNet Bundle assigns digital audio data to a particular bundle.  CobraNet 
Bundle Numbers are used to match those of any third-party CobraNet D/A 
converters being used in the system.  Normally, ’unicast’ bundles 256 ~ 61,439 
are selectable.  These are device specific bundles (for exchange of digital audio 
with only one other device).    Multicast allows selection of bundles 1 ~ 255, 
which are not device specific (for exchange of digital audio with multiple 
devices).  Enable turns on/off the exchange of CobraNet digital audio data from 
this device. 

 

Right-clicking over certain settings will provide a menu of additional options. 

 

Mixers 

  

These Component Objects provide typical audio mixing functions, in five categories:  Standard Mixers;  Matrix 
Mixers;  Auto Mixers;  Mix-Minus Combiners; and Room Combiners.  Mix-Minus Combiners are provided to 
enhance the capabilities of Auto Mixers in mix-minus and input expansion applications.  Room Combiners are 
provided to enhance the capabilities of Auto Mixers in room combining and zone routing applications.  Mixers are 
available in pre-defined configurations, however, the configuration may be customized when being placed from the 
Object Toolbar. 

Once a Component Object is placed into the Layout, all available settings can be accessed by double-clicking over the 
object.  This produces a Control Dialog Box, which displays the component controls in a more conventional user 
interface. 

 see Standard Mixers Control Dialog 

 see Matrix Mixers Control Dialog 

 see Auto Mixers Control Dialog 

 see Mix-Minus Combiners Control Dialog 

 see Room Combiners Control Dialog 

Right-clicking over the object provides a pop-up menu of options.  Control Dialog Boxes for Room Combiner 
components can be minimized to create user control surfaces (see Customizing Component Objects). 
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Control Dialog 
 

Standard Mixers Control Dialog 

  

Mute In turns the input signal on/off.  Level In adjusts the relative 
input volume.  Ch / Bus assigns inputs to specific outputs.  Mute 
Out turns the output signal on/off.  Level Out adjusts the relative 
output volume. 

 

Right-clicking over certain settings will provide a menu of additional 
options. 

 

 

Matrix Mixers Control Dialog 

  

 

Mute In turns the input signal on/off.  Level 
In adjusts the relative input volume.  Ch / 
Bus assigns inputs to specific outputs, and  
right-clicking allows level adjustment.  Mute 
Out turns the output signal on/off.  Level 
Out adjusts the relative output volume. 

 

Matrix Mixers w/Delay are also available.  
Mix Table assigns Ch / Bus to affect either 
level or delay settings. 

 

Right-clicking over certain settings will 
provide a menu of additional options. 

 

 



 44 

Auto Mixers Control Dialog 

  

  

  

  

Mute In turns the input signal on/off.  Level In adjusts the relative 
input volume.  Ch / Bus assigns inputs to the output.  Mute Out 
turns the output signal on/off.  Level Out adjusts the relative output 
volume. 

 

Mic Options opens a separate control dialog box to establish global 
settings. 

 

Designated Mic On / Last Mic Hold determines which microphone 
(if any) will stay/become active when no signal is present.  Logic 
Outputs Follow Mic Logic assigns logic outputs to follow 
Designated Mic On / Last Mic Hold.  Open Mic Limits enables (and 
designates) a maximum allowable number of active microphones. 

 

Right-clicking over Ch / Bus assignments allows selection of two 
additional dialog boxes. 

 

Channel Settings affects individual channel settings, but may be 
applied to all channels. 

 

Manual turns on/off channel gating.  NOM Gain turns on/off 
channel contribution to NOM (number of open mics) attenuation.  
Direct Output designates channel direct output signal as Post Gate / 
Pre NOM, Post Gate / Post NOM, or Off.  (Direct Outputs must be 
enabled when placing Auto Mixers from the Object Toolbar.)  Set 
All causes current Channel Settings to be applied to all channels.  
Off Attenuation determines the amount of attenuation applied when 
channel is inactive.  Gate Hold Time determines length of time 
before channel becomes inactive, once signal is no longer present. 

 

Logic Outputs affects individual Logic Output settings, but may be 
applied to all Logic Outputs.  (Logic Outputs must be designated 
when placing Auto Mixers from the Object Toolbar.) 

 

Logic Output selects Follow Gate, On, or Off condition of the Logic 
Output.  Invert reverses operation of the Logic Output (off when 
channel active).  Turn On Delay & Turn Off Delay determine the 
length of time Logic Output functions lag behind channel gating 
activity.  Set All causes current Logic Output settings to be applied 
to all channels. 

 

Right-clicking over certain settings will provide a menu of additional 
options. 
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Mix-Minus Combiners Control Dialog 

  

Mix-Minus Combiners are provided to enhance the capabilities of Auto Mixers in 
mix-minus and input expansion applications.  Mix-Minus Combiners combine 
control data only and, therefore, have no audio outputs.  Inputs to a Mix-Minus 
Combiner come from outputs of separate Auto Mixers.  Ch / Combine allows input 
channels (1, 2, 3 etc.) to be grouped into specific combinations (A, B, C, etc.).  
These combinations automatically determine proper routing of control data for the 
Auto Mixers.  Control data represents NOM (number of open mics) and ATS 
(adaptive threshold sensing) information.  Mix-Minus Combiners are used when the 
Auto Mixer outputs are also connected to a separate Matrix Mixer (to create 
multiple ’mix-minus’ outputs).  Also, Mix-Minus Combiners allow large Auto 
Mixers to be created from multiple, smaller ones.  This is useful when more than 32 
inputs are required, or when an Auto Mixer must be placed into multiple Audia 
units (for proper DSP allocation or for physical location of inputs). 

 

Right-clicking over certain settings will provide a menu of additional options. 

 

 

Room Combiners Control Dialog 

Room Combiners are provided to enhance the capabilities of Auto Mixers in room combining and zone routing 
applications.  Room Combiners automatically determine proper routing of audio signals & control data for the Auto 
Mixers.  Control data represents NOM (number of open mics) and ATS (adaptive threshold sensing) information.  
Room Combiners are available only from the Object Toolbar (not from the Processing Library). 

  

When a Room Combiner is placed, an 
Initialization Properties dialog box 
appears for creating physical relationships 
between rooms.  The overall space is first 
defined by left-clicking multiple squares 
(non-contiguous rooms are allowed).  
Right-clicking then provides a menu of 
additional options, such as Merge 
adjacent squares into larger rooms, and 
Isolate rooms which have no moveable 
partitions.  Enable Control Inputs 
provides the Room Combiner with 
control nodes, which allow combining via 
external devices (see Controls). 
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Once a Room Combiner is placed, the Control Dialog Box is available, 
which displays the overall space, including zones, partitions, levels, and 
mutes.  Moveable partitions are numbered relative to control input nodes 
on the block.  Combining may be accomplished ’automatically’ by 
manipulation of these partitions.  Moveable partitions can be 
opened/closed by means of external controls (see Controls & RS-
232/Telnet).  Combining can instead be accomplished by recalling stored 
preset configurations.  Preset configurations must first be created, then 
recalled through either a Software User Interface or external controls (see 
Controls & RS-232/Telnet). 

 

The Room Combiner dialog box allows rooms to be combined in groups, 
which are color-coded and numbered for identification.  This can be used 
for real-time software control, or to generate various configurations to be 
stored as presets.  Rooms can be grouped by manipulating partitions 
(using the mouse), or by selecting multiple rooms while holding Shift or 
Ctrl.  This last approach allows non-contiguous and isolated rooms to be 
included in combined groups.  Right-clicking on a room provides a menu 
of sixteen available groups.  Level and mute adjustments become ganged 
for all rooms combined in the same group. 

Right-clicking over certain settings will provide a menu of additional options.  Control Dialog Boxes for Room 
Combiner components can be minimized to create user control surfaces (see Customizing Component Objects). 

 

 

 

Equalizers 

  

These Component Objects provide both graphic and parametric equalizers.  Equalizers may be connected between any 
components within the Layout, for applications which require room equalization and/or tone control.  Equalizers are 
available in pre-defined configurations, however, the configuration may be customized when being placed from the 
Object Toolbar. 

Once a Component Object is placed into the Layout, all available settings can be accessed by double-clicking over the 
object.  This produces a Control Dialog Box, which displays the component controls in a more conventional user 
interface. 

 see Graphic Equalizer Control Dialog 

 see Parametric Equalizer Control Dialog 

Right-clicking over the object provides a pop-up menu of options. 
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Control Dialog 
 

Graphic Equalizer Control Dialog 

  

Active Band selects the current band to be adjusted.  Center Freq. displays the center frequency for the current band.  
Gain adjusts the amount of cut or boost applied at the center frequency for the current band.  Active Band and Gain 
may also be adjusted by dragging the band controls shown inside the graph.  The selected band control becomes yellow, 
and dragging it up/down affects Gain for that band.  Flatten Band & Flatten All change the band(s) Gain to ’0’ (flat).  
Bypass Band & Bypass All disable the band(s) without changing settings.  Drag Points turns on/off the band controls, 
revealing the resultant curve only. 

 

Right-clicking over certain settings will provide a menu of additional options. 
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Parametric Equalizer Control Dialog 

  

Active Band selects the current band to be adjusted.  Center Freq. adjusts the center frequency for the current band.  
Gain adjusts the amount of cut or boost applied at the center frequency for the current band.  Bandwidth adjusts the 
range of frequencies, above & below the center frequency, which are also affected by the current band.  These settings 
may also be adjusted by dragging the band controls shown inside the graph.  Dragging the white dot affects both Center 
Freq. & Gain.  Dragging either yellow dot affects Bandwidth.  Flatten Band & Flatten All change the band(s) Gain to 
’0’ (flat).  Bypass Band & Bypass All disable the band(s) without changing settings.  Drag Points turns on/off the band 
controls, revealing the resultant curve only.  Band highlights the current band inside the graph. 

 

Right-clicking over certain settings will provide a menu of additional options. 

 

 

Filters 

  

These Component Objects provide High-Pass, Low-Pass, High-Shelf, & Low-Shelf filters.  Filters may be connected 
between any components within the Layout, for applications which require ’roll-offs’ and/or simple tone control. 

Once a Component Object is placed into the Layout, all available settings can be accessed by double-clicking over the 
object.  This produces a Control Dialog Box, which displays the component controls in a more conventional user 
interface. 

 see High Pass Filter Control Dialog 

 see Low Pass Filter Control Dialog 

 see High Shelf Filter Control Dialog 

 see Low Shelf Filter Control Dialog 

Right-clicking over the object provides a pop-up menu of options. 
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Control Dialog 
 

High Pass Filter Control Dialog 

  

Filter / Slope selects the type (Linkwitz-Riley or 
Butterworth) and slope of the filter.  Cutoff Freq. 
selects the cutoff frequency for the filter.  Cutoff Freq. 
may also be adjusted by dragging the cursor shown 
inside the graph.  Bypass Band disables the filter 
without changing settings. 

 

Right-clicking over certain settings will provide a menu 
of additional options. 

 

 

Low Pass Filter Control Dialog 

  

Filter / Slope selects the type (Linkwitz-Riley or 
Butterworth) and slope of the filter.  Cutoff Freq. 
selects the cutoff frequency for the filter.  Cutoff Freq. 
may also be adjusted by dragging the cursor shown 
inside the graph.  Bypass Band disables the filter 
without changing settings. 

 

Right-clicking over certain settings will provide a menu 
of additional options. 
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High Shelf Filter Control Dialog 

  

Gain selects the amount of maximum cut or boost 
applied by the filter.  Cutoff Freq. selects the cutoff 
frequency for the filter.  These settings may also be 
adjusted by dragging the cursor shown inside the graph. 
Bypass Band disables the filter without changing 
settings. 

 

Right-clicking over certain settings will provide a menu 
of additional options. 

 

 

Low Shelf Filter Control Dialog 

  

Gain selects the amount of maximum cut or boost 
applied by the filter.  Cutoff Freq. selects the cutoff 
frequency for the filter.  These settings may also be 
adjusted by dragging the cursor shown inside the graph. 
Bypass Band disables the filter without changing 
settings. 

 

Right-clicking over certain settings will provide a menu 
of additional options. 
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Crossovers 

  

These Component Objects provide 2-way, 3-way, & 4-way crossover functions.  Crossovers may be connected 
between any components within the Layout, for applications which require multiple outputs with specified frequency 
ranges. 

Once a Component Object is placed into the Layout, all available settings can be accessed by double-clicking over the 
object.  This produces a Control Dialog Box, which displays the component controls in a more conventional user 
interface. 

 see 2-Way Crossover Control Dialog 

 see 3-Way Crossover Control Dialog 

 see 4-Way Crossover Control Dialog 

Right-clicking over the object provides a pop-up menu of options. 

 

Control Dialog 
 

2-Way Crossover Control Dialog 

  

Input Level provides muting and level adjustment for the input.  Output Range selects the Low or High frequency 
output.  Frequency selects the filter cutoff frequency for the selected output.  Output Range & Frequency may also be 
selected by dragging the cursors shown inside the graph.  Filter / Slope selects the type (Linkwitz-Riley or 
Butterworth) and slope of filter used at the associated Frequency.  Output Level provides muting, level adjustment, & 
polarity (phase) reversal for the selected output.  Sync forces filter adjustments on adjacent outputs to be linked.  
Settings for each output are displayed across the bottom of the dialog box. 

Right-clicking over certain settings will provide a menu of additional options. 
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3-Way Crossover Control Dialog 

  

Input Level provides muting and level adjustment for the input.  Output Range selects the Low, Mid, or High 
frequency output.  Frequency selects the filter cutoff frequencies for the selected output.  Output Range & Frequency 
may also be selected by dragging the cursors shown inside the graph.  Filter / Slope selects the type (Linkwitz-Riley 
or Butterworth) and slope of filter used at the associated Frequency.  Output Level provides muting, level adjustment, 
& polarity (phase) reversal for the selected output.  Sync forces filter adjustments on adjacent outputs to be linked.  
Settings for each output are displayed across the bottom of the dialog box. 

Right-clicking over certain settings will provide a menu of additional options. 

 

 



 53 

4-Way Crossover Control Dialog 

  

Input Level provides muting and level adjustment for the input.  Output Range selects the Low, Low-Mid, Mid-
High, or High frequency output.  Frequency selects the filter cutoff frequencies for the selected output.  Output Range 
& Frequency may also be selected by dragging the cursors shown inside the graph.  Filter / Slope selects the type 
(Linkwitz-Riley or Butterworth) and slope of filter used at the associated Frequency.  Output Level provides muting, 
level adjustment, & polarity (phase) reversal for the selected output.  Sync forces filter adjustments on adjacent 
outputs to be linked.  Settings for each output are displayed across the bottom of the dialog box. 

Right-clicking over certain settings will provide a menu of additional options. 

 

 

Dynamics 

  

These Component Objects provide Leveler, Comp/Limiter, Ducker, & Noise Gate functions. Dynamics components 
may be connected between any other components within the Layout, for applications which require automatic control 
of volume levels and/or dynamics. 

Once a Component Object is placed into the Layout, all available settings can be accessed by double-clicking over the 
object.  This produces a Control Dialog Box, which displays the component controls in a more conventional user 
interface. 

 see Leveler Control Dialog 

 see Comp/Limiter Control Dialog 

 see Ducker Control Dialog 

 see Noise Gate Control Dialog 

Right-clicking over the object provides a pop-up menu of options.  Control Dialog Boxes for some Dynamics 
components can be minimized to create user control surfaces (see Customizing Component Objects). 
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Control Dialog 
 

Leveler Control Dialog 

  

Levelers are automatic gain controls, which affect long-term average levels.  
Response Time determines how quickly the Leveler reacts to input level changes.  
Threshold determines what input level will trigger gain reduction.  To maintain a 
consistent level, set Threshold to lowest desired level.  A meter & numeric display 
indicate the amount of gain reduction.  Identifier provides a custom label, when 
dialog box is minimized (see below).  Bypass disables the Leveler without 
changing settings. 

 

Right-clicking over certain settings will provide a menu of additional options.  
Control Dialog Boxes for Levelers can be minimized to create user control 
surfaces (see Customizing Component Objects). 

 

 

Comp/Limiter Control Dialog 

  

Comp/Limiters affect short-term signal dynamics (peaks).  
Attack determines how quickly the Comp/Limiter reacts to 
input level changes.  Compression Ratio determines the 
intensity of gain reduction (input level increase vs. output level 
increase).  Release Time determines how quickly gain reduction 
is released, once input signal falls below Threshold.  Threshold 
determines what input level will trigger gain reduction.  A meter 
& numeric display indicate the amount of gain reduction.  
Bypass disables the Comp/Limiter without changing settings.  
Identifier provides a custom label, when dialog box is 
minimized (see below). 

 

Right-clicking over certain settings will provide a menu of 
additional options.  Control Dialog Boxes for Comp/Limiters 
can be minimized to create user control surfaces (see 
Customizing Component Objects). 
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Ducker Control Dialog 

  

Duckers provide level attenuation, triggered by signal or logic 
inputs.  Input Level provides muting and level adjustment for the 
normal audio input, which appears as the upper input, on the left 
side of the Ducker.  Sense Level provides muting and level 
adjustment for the signal trigger input, which appears as the lower 
input, on the left side of the Ducker.  Threshold determines what 
sense input signal level will trigger ducking.  Ducking Level 
determines how much attenuation is applied to the normal audio 
signal during ducking.  Attack determines how quickly the ducker 
reacts to trigger input (signal or logic).  Release determines how 
quickly attenuation is released, once trigger input is removed (signal 
or logic).  Logic In turns on/off and reverses operation (off triggers 
ducking) of the logic trigger input.  Logic Out provides the same 
functions as Logic In, but instead as a trigger output (which follows 
ducking activity).  Mix Sense allows the Sense input signal to be 
mixed with normal audio input signal, at the output of the Ducker.  
Bypass disables the Ducker without changing settings. 

 

Right-clicking over certain settings will provide a menu of 
additional options. 

 

 

Noise Gate Control Dialog 

  

Noise Gates provide automatic muting, until triggered by signal 
presence.  Attack Time determines how quickly the gate opens 
when signal is present.  Release Time determines how quickly 
the gate closes when signal is no longer present.  Threshold 
determines what input signal level will trigger the gate to open.  
A meter & numeric display indicate the amount of gain reduction. 
Identifier provides a custom label, when dialog box is minimized 
(see below).  Bypass disables the Noise Gate without changing 
settings. 

 

Right-clicking over certain settings will provide a menu of 
additional options.  Control Dialog Boxes for Noise Gates can be 
minimized to create user control surfaces (see Customizing 
Component Objects). 
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Routers 

  

These Component Objects provide typical audio routing functions.  Routers may be connected between any 
components within the Layout, for applications which require routing of input signals to various outputs.  Routers are 
available in pre-defined configurations, however, the configuration may be customized when being placed from the 
Object Toolbar. 

Once a Component Object is placed into the Layout, all available settings can be accessed by double-clicking over the 
object.  This produces a Control Dialog Box, which displays the component controls in a more conventional user 
interface. 

 see Router Control Dialog 

Right-clicking over the object provides a pop-up menu of options. 

 

Control Dialog 
 

Router Control Dialog 

  

Routers allow each input to be assigned to multiple outputs via In / Out.  However, 
each output allows only one input assigned at a time.  Therefore, Routers behave 
like a series of individual distribution amplifiers.  For increased input/output 
assignment capability, see Mixers. 

 

Right-clicking over certain settings will provide a menu of additional options. 

 

 

Delays 

  

These Component Objects provide typical audio time-delay functions.  Delays may be connected between any 
components within the Layout, for applications which require room delay and/or loudspeaker time-alignment. 

Once a Component Object is placed into the Layout, all available settings can be accessed by double-clicking over the 
object.  This produces a Control Dialog Box, which displays the component controls in a more conventional user 
interface. 

 see Delay Control Dialog 

Right-clicking over the object provides a pop-up menu of options. 
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Control Dialog 
 

Delay Control Dialog 

  

Value determines the amount of delay, based on the 
selected Units.  Units selects either time (milliseconds) or 
distance (meters, centimeters, feet, or inches).  Bypass 
disables the Delay without changing settings.  

 

Right-clicking over certain settings will provide a menu 
of additional options. 

 

 
 

Controls 

  

These Component Objects provide both internal and external control functions.  Level Controls and Mute Buttons may 
be connected between components within the Layout, for control of volume and muting.  Preset and Remote Preset 
Buttons may be placed within the Layout, and defined to recall specified Presets.  Logic Gates may be connected 
between component control nodes in the layout, to customize control behavior.  Volume 8, Select 8, Volume/Select 8, 
and Logic Box components may be placed within the layout, to represent their corresponding external control devices.  
Controls are available in pre-defined configurations, however, the configuration may be customized when being 
placed from the Object Toolbar. 

Once a Component Object is placed into the Layout, all available settings can be accessed by double-clicking over the 
object.  This produces a Control Dialog Box, which displays the component controls in a more conventional user 
interface. 

 see Level Control Dialog 

 see Mute Button Control Dialog 

 see Preset Button Control Dialog 

 see Remote Preset Button Control Dialog 

 see Logic Gates 

 see Volume 8 Control Dialog 

 see Select 8 

 see Volume/Select 8 Control Dialog 

 see Logic Box 

Right-clicking over the object provides a pop-up menu of options.  Control Dialog Boxes for Level, Mute, and Preset 
related components can be minimized to create user control surfaces (see Customizing Component Objects). 
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Control Dialog 
 

Level Control Dialog 

  

Mute turns on/off the channel.  Channel level may be 
entered numerically, or may be adjusted by dragging the 
fader.  Maximum and Minimum can be used to restrict 
the range of level adjustment provided by the fader.  
Level ID provides a custom label, when the dialog box is 
minimized (see below).   

 

Right-clicking over certain settings will provide a menu 
of additional options.  Control Dialog Boxes for Level 
Control components can be minimized to create user 
control surfaces (see Customizing Component Objects). 

 

When placed from the Object Toolbar, multiple Level 
Controls may be ’ganged’ together onto a single fader.  
Ganged Level Controls display a ’G’ in the upper-right of 
the Component Object, and Level ID colors are reversed 
on the Control Dialog.  Non-ganged Level Controls have 
a maximum of eight channels, whereas ganged Level 
Controls have a maximum of forty channels. 

 

 

Mute Button Control Dialog 

  

Mute turns on/off the channel.  Identifier provides a custom label, when the dialog 
box is minimized (see below).   

 

Right-clicking over certain settings will provide a menu of additional options.  
Control Dialog Boxes for Mute Button components can be minimized to create user 
control surfaces (see Customizing Component Objects). 

 

When placed from the Object Toolbar, multiple Mute Buttons may be ’ganged’ 
together onto a single button.  Ganged Mute Buttons display a ’G’ in the upper-right 
of the Component Object, and Indentifier colors are reversed on the Control Dialog.  
Non-ganged Mute Buttons have a maximum of eight channels, whereas ganged 
Mute Buttons have a maximum of forty channels. 
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Preset Button Control Dialog 

  

Right-clicking over a button provides a list of available Presets which 
can be assigned to that button.  The Preset Number will appear on the 
button, and the Preset Name will appear to the right.  Control Dialog 
Boxes for Preset Button components can be minimized to create user 
control surfaces (see Customizing Component Objects). 

 

 

Remote Preset Button Control Dialog 

  

Remote Preset Buttons are identical to Preset Buttons, except they 
have control input nodes on the block.  These control input nodes 
allow presets to be recalled via control output nodes on other 
component blocks. This provides remote control of preset selection, 
both from internal components and external controls.  Control Dialog 
Boxes for Remote Preset Button components can be minimized to 
create user control surfaces (see Customizing Component Objects). 
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Logic Gates 

Most Logic Gates have no Control Dialog Boxes.  They are used only to customize behavior of other control functions 
in the system.  Logic Gates are connected between the output and input control nodes of other components in the layout.  
These components can represent internal or external control functions. 

Examples 

Internal:  Auto Mixer output nodes;  Ducker input/output nodes;  Remote Preset Button input nodes. 

External:  Select 8 output nodes;  Volume/Select 8 output nodes;  Logic Box input/output nodes. 

 

Logic Gates alter the normal operation of component control outputs in the following ways: 

NOT:  produces opposite/inverted operation (input ON turns output OFF;  input OFF turns output ON). 

AND:  all inputs ON causes output to go ON (any inputs OFF causes output to go OFF). 

NAND:  all inputs ON causes output to go OFF (any inputs OFF causes output to go ON). 

OR:  any inputs ON causes output to go ON (all inputs OFF causes output to go OFF). 

NOR:  any inputs ON causes output to go OFF (all inputs OFF causes output to go ON). 

XOR:  any inputs (except all) ON causes output to go ON (all inputs OFF/ON causes output to go OFF). 

Flip Flop:  produces toggle/latching operation (input ON changes output state, ON/OFF). 

NOTES:  NOT and Flip Flop gates have only a single input per output, whereas other gates have multiple inputs, up to 
8.  Flip Flop gates provide a control dialog box, for establishing their initial output state. 

 

Sample Application 

  

Normally, a Select 8 control output connected to a Ducker control input 
provides a momentary operation (ducking occurs only as long as the Select 8 
control is being pressed).  However, connecting a Flip Flop Logic Gate 
between the Select 8 control output and the Ducker control input produces a 
press-on/press-off operation (ducking begins with the first press of the Select 8 
control, and ceases only upon a second press of the Select 8 control). 
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Volume 8 Control Dialog 

  

  

The Volume 8 is an external control device, which allows adjustment 
of eight selectable Audia volumes.  Volumes can be individual or 
grouped levels within Audia.  This includes Level Control blocks, as 
well as levels within other component blocks (such as Inputs/Outputs, 
Mixers, Equalizers, etc.). 

 

Volume 8 is represented in the layout as a block with no audio or 
control connections.  All functions are assigned using the control 
dialog box.  Object Code selects from a list of blocks found in the 
layout, and Instance ID is entered automatically, but both can be 
found easily using Object ID Inspector.  Control ID selects from a 
list of available levels within the chosen block.  Volume up/down 
buttons allow control of assigned levels directly from the dialog box.  
Identifier provides a custom label, when the dialog box is minimized 
(see below).   

 

Control Dialog Boxes for Volume 8 components can be minimized to 
create user control surfaces (see Customizing Component Objects). 

Volume 8 controls include a raceway (surface-mount) back-box, but will fit most US standard single-gang (flush-
mount) back-boxes.  Custom Control Labels may be printed for the Volume 8.  Please refer to the ’Installation Guide’ 
(included with controls), or see Control Bus for more information.  External controls must be identified (see Device 
Maintenance) and associated with their corresponding component blocks within the layout (see Equipment Table). 
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Select 8 

  

The Select 8 is an external control device, which allows 
initiation of eight selectable Audia actions.  Actions can be 
individual or grouped functions within Audia.  This includes 
recalling presets, ducking, combining, etc. 

 

Select 8 components have no Control Dialog Boxes.  They are 
represented in the layout as a block with eight control output 
nodes.  These control output nodes are connected to control 
input nodes on the other component blocks to be controlled.  
These other components may include Remote Preset Buttons, 
Duckers, Room Combiners, and Logic Boxes.  Muting and 
room combining routines can also be achieved using presets.  
Logic Boxes can provide logic outputs for controlling 
additional equipment, external to Audia. 

 

Select 8 behavior can be altered using Logic Gates. 

  

Select 8 controls include a raceway (surface-mount) back-box, but will fit most 
US standard single-gang (flush-mount) back-boxes.  Custom Control Labels 
may be printed for the Select 8.   

Please refer to the ’Installation Guide’ (included with controls), or see Control Bus for more information.  External 
controls must be identified (see Device Maintenance) and associated with their corresponding component blocks within 
the layout (see Equipment Table). 
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Volume/Select 8 Control Dialog 

  

  

The Volume 8 is an external control 
device, which combines the functions 
of both Volume 8 and Select 8 controls. 

 

Therefore, the Volume/Select 8 is 
represented with a control dialog box 
(for volume functions), as well as a 
component block with control output 
nodes (for select functions). 

 

Control Dialog Boxes for 
Volume/Select 8 components can be 
minimized to create user control 
surfaces (see Customizing Component 
Objects). 

  

Volume/Select 8 controls include a raceway (surface-mount) back-box, 
but will fit most US standard single-gang (flush-mount) back-boxes.       

Custom Control Labels may be printed for the Volume/Select 8.  Please refer to the ’Installation Guide’ (included with 
controls), or see Control Bus for more information.  External controls must be identified (see Device Maintenance) and 
associated with their corresponding component blocks within the layout (see Equipment Table). 
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Logic Box 

  

The Logic Box is an external control device, which provides 
twenty logic input/output connections.  When a Logic Box is 
placed, an Initialization Properties dialog box appears for 
assigning the quantities of logic inputs/outputs (20 total).  Logic 
inputs allow external switches to initiate Audia actions.  Actions 
can be individual or grouped functions within Audia.  This 
includes recalling presets, ducking, combining, etc.  Logic outputs 
can be used to control additional equipment, external to Audia. 

  

Logic Box components have no Control Dialog Boxes.  They are represented in the layout as a block with a total of 
twenty control input/output nodes.  Logic Inputs (on the box) are represented as control output nodes (on the block).  
These control output nodes may be connected to control input nodes on other components, such as Remote Preset 
Buttons, Duckers, and Room Combiners.  Logic Outputs (on the box) are represented as control input nodes (on the 
block).  These control input nodes may be connected to control output nodes on other components, such as Auto 
Mixers, Duckers, and Select 8.  Unlike other components, Logic Box output nodes may be connected to input nodes 
on the same Logic Box block, allowing Logic Inputs (external switches) to control Logic Outputs (external 
equipment). 

  

Logic Box behavior can be altered using Logic Gates.  Please refer to the ’Installation 
Guide’ (included with controls), or see Control Bus for more information.  External 
controls must be identified (see Device Maintenance) and associated with their 
corresponding component blocks within the layout (see Equipment Table). 
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Control Labels 

The Volume 8, Select 8, and Volume/Select 8 controls all come with a sheet of clear, adhesive-backed 
labels, for custom printing on a laser printer.  A Word document (V8S8 Labels.doc) is available on the 
Audia software CD and the Biamp web site (www.biamp.com), as a label printing template.  These labels 
are meant to be printed using desk-top laser printers only.  It is recommended that the printer be set for 
’label’ printing, and the label sheet should be ’short-edge’ feed from the ’bypass’ tray.  A test printing of a 
single label should be done, to assure proper alignment of text.  To compensate for any mis-alignment of 
text, margins within the Word document may be adjusted.  Care should be taken in placement of the 
labels onto the controls.  To avoid finger-prints, the use of a knife-blade or tweezers is recommended for 
handling.  Severe bending or curling of the label may cause loss of some toner (text).  When placing the 
label on the control panel, use the vertical column of LED indicators as a visual reference of alignment.  
Once the label is in place, a second (un-printed) label may be placed over the first label, to provide 
protection against wear.  Each sheet contains 25 labels, so in case of errors, additional labels may be 
printed. 

 

In the label template (V8S8 Labels.doc), select Show Gridlines from the Table menu.  Each large cell represents a 
label.  The first four columns are ’left-justified’ to create labels for Volume 8 and Select 8 panels, as well as for the 
’Volume’ (left) section of Volume/Select 8 panels.  The last column is ’right-justified’ to create labels for the ’Select’ 
(right) section of Volume/Select 8 panels.  Left-click inside any large cell, and begin typing.  Use ’Enter’ to begin a new 
line, and again to leave a blank line.  To avoid printing errors, do not change line-spacing or other formatting 
parameters.  However, if you do not have the default font (Helvetica), or if you wish to change label appearance, you 
may select a different font before typing. 

 

 

Meters 

  

These Component Objects provide signal present, peak, and RMS metering functions.  Meters may be connected to 
any component output, and may be used for diagnostic and setup purposes, or for applications which require real-time 
metering.  Meters are available in pre-defined configurations, however, the configuration may be customized when 
being placed from the Object Toolbar. 

Once a Component Object is placed into the Layout, all available settings can be accessed by double-clicking over the 
object.  This produces a Control Dialog Box, which displays the component controls in a more conventional user 
interface. 

 see Signal Present Meter Control Dialog 

 see Peak Meter Control Dialog 

 see RMS Meter Control Dialog 

Right-clicking over the object provides a pop-up menu of options.  Control Dialog Boxes for Meters components can 
be minimized to create user control surfaces (see Customizing Component Objects). 
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Control Dialog 
 

Signal Present Meter Control Dialog 

  

Threshold determines at what level the signal present indicator 
will light.  Identifier provides a custom label, when dialog box 
is minimized (see below). 

 

Right-clicking over certain settings will provide a menu of 
additional options.  Control Dialog Boxes for Meters 
components can be minimized to create user control surfaces 
(see Customizing Component Objects). 

 

 

Peak Meter Control Dialog 

  

A peak-reading meter & numeric display indicate signal level.  Hold Time 
determines how long the meter will display the most recent level increase.  Hold 
Enable turns the Hold Time function on/off.  Indefinite Hold causes the Hold 
function to be continuous, updating the display only when levels increase 
beyond the current reading.  Identifier provides a custom label, when dialog 
box is minimized (see below). 

 

Right-clicking over certain settings will provide a menu of additional options.  
Control Dialog Boxes for Meters components can be minimized to create user 
control surfaces (see Customizing Component Objects). 

 

 

RMS Meter Control Dialog 

  

An RMS-reading meter & numeric display indicate signal level.  Hold Time 
determines how long the meter will display the most recent level increase.  Hold 
Enable turns the Hold Time function on/off.  Indefinite Hold causes the Hold 
function to be continuous, updating the display only when levels increase 
beyond the current reading.  Identifier provides a custom label, when dialog 
box is minimized (see below). 

 

Right-clicking over certain settings will provide a menu of additional options.  
Control Dialog Boxes for Meters components can be minimized to create user 
control surfaces (see Customizing Component Objects). 
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Generators 

  

These Component Objects provide sine-wave, sweep, pink-noise, and white-noise generator functions.  Generators 
may be connected to any component input, and may be used for diagnostic and setup purposes, or for applications 
which require tones or sound-masking. 

Once a Component Object is placed into the Layout, all available settings can be accessed by double-clicking over the 
object.  This produces a Control Dialog Box, which displays the component controls in a more conventional user 
interface. 

 see Tone Generator Control Dialog 

 see Pink Noise Generator Control Dialog 

 see White Noise Generator Control Dialog 

Right-clicking over the object provides a pop-up menu of options. 

 

Control Dialog 
 

Tone Generator Control Dialog 

  

Tone selects a single frequency.  Sweep selects a range of 
frequencies (instead of a single tone).  Mute turns on/off the 
generator.  Level determines the generator output level.  
Frequency determines the frequency for Tone.  Start 
Frequency & Stop Frequency determine the range of 
frequencies for Sweep.  Frequency Interval selects the 
spacing (and quantity) of individual tones for Sweep.  Time 
Interval determines the time each tone is held for Sweep.  

 

Right-clicking over certain settings will provide a menu of 
additional options. 

 

Pink Noise Generator Control Dialog 

  

Mute turns on/off the generator.  Level determines generator output level. 

 

Right-clicking over certain settings will provide a menu of additional options. 
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White Noise Generator Control Dialog 

  

Mute turns on/off the generator.  Level determines generator output level. 

 

Right-clicking over certain settings will provide a menu of additional options. 

 

 

Diagnostics 

  

These Component Objects provide Transfer Function displays for diagnostic purposes.  Transfer Function may be 
connected between any two component outputs on the same signal path, for a comparative analysis of processing. 

Once a Component Object is placed into the Layout, all available settings can be accessed by double-clicking over the 
object.  This produces a Control Dialog Box, which displays the component controls in a more conventional user 
interface. 

 see Transfer Function Control Dialog 

Right-clicking over the object provides a pop-up menu of options. 

 

Control Dialog 
 

Transfer Function 

  

Transfer Function may be connected between any two component outputs on the same signal path, for a 
comparative analysis of processing.  Gain displays the difference in frequency response between the two 
comparison points, as a white line.  Phase displays the phase relationship between the two comparison points, 
as a green line.  Unwrap removes out-of-range phase rotations from the phase display.  Delays adds the effect 
of user-placed delay blocks (Delay and Matrix Mixer w/ Delay) into the phase display.  The Phase display does 
not indicate inherent propagation delay within the system.  When a Transfer Function dialog box is open, the 
associated signal path is indicated as a dashed red line in the layout. 
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System Design 
 

Placing Component Objects 

Audia(TM) system design begins with the placement of Component Objects into the Layout.  This can be done in two 
ways.  The simplest way is to select a component category from the Processing Library, and then drag & drop a pre-
defined component into the Layout.  Processing Library component categories can also be selected from the 
Processing Library Menu (at the top of the screen), which indicates keyboard short-cuts as well.  However, component 
placement can instead be done using the Object Toolbar, located directly above the Layout.  On the Object Toolbar, 
next to each category icon is a drop-down menu of components.  Selecting a component from the menu, then clicking 
over the Layout, will place the selected component at that location.  Holding the Shift key allows multiple copies of 
the component to be placed.  Certain components will provide a pop-up window, allowing further component 
definition & customization before placement.  Using the Object Bar also allows the Processing Library to be closed 
(providing greater width to the Layout).  Component Objects, and their current settings (DSP data), can also be placed 
using the Copy/Paste functions on the Standard Toolbar or the Edit Menu.  Selected objects can also be copied by 
holding the Alt key while dragging and dropping.  NOTE:  Components cannot be selected when the current Layer is 
invisible (see Layers Sheet). 

 

Arranging Component Objects 

The physical arrangement of objects within the Layout can be modified in several ways.  Objects can be packed side-
by-side, have their edges aligned, be centered in the view, be spaced evenly, and be made the same size.  Objects can 
also be arranged from front to back, when multiple objects are overlaid.  In addition, objects can be forced to snap to 
an adjustable grid.  See Layout Toolbar and Layout Menu.  Objects within the Layout can also be organized in 
separate groups called Layers (see Layers Sheet).   

 

Connecting Component Objects 

Each Component Object includes Nodes for making system wiring connections.  Nodes are provided in four types, 
each with a specific location on the Component Object.  Audio input Nodes are always on the left.  Audio outputs 
Nodes are always on the right.  Control (logic) input Nodes are always on the top.  Control (logic) output Nodes are 
always on the bottom.  When an object (such as a Ducker) includes an audio control (sense) input, it will be below the 
audio inputs (on the left). 

To make a connection, select a Node and drag/drop a Line Object (wire) to a corresponding Node.  Multiple Nodes on 
one object can be selected, and then connected to a matching set of multiple Nodes on another object.  If multiple 
Nodes from individual objects are to be connected to multiple Nodes on a single object, select the individual object 
Nodes first (drag to select as group).  Nodes from multiple individual objects must be connected to Nodes of other 
individual objects one at a time. 

An output Node can be connected to multiple input Nodes, but an input Node cannot be connected to multiple output 
Nodes.  Audio Nodes & Control (logic) Nodes cannot be connected to each other.  Input & Output Nodes on the same 
object cannot be connected to each other.  Nodes of the same type (Input or Output) cannot be connected together. 

An individual Line Object (wire) or Node connection can be moved (but not copied).  The appearance & properties of 
Line Objects (wires) in the Layout can be changed (see Format Toolbar and Property Sheet).  
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Component Object Properties 

Component Object Properties are the control settings available for each component.  These represent the same settings 
normally found on equivalent analog audio products.  Component Object Properties for a selected component can be 
viewed/edited (in table form) using the Object Property Sheet.  They can also be copied & pasted (as DSP Data) 
between identical components, using the Edit Menu.  However, once a Component Object is placed into the Layout, 
all available settings can be accessed by double-clicking over the object.  This produces a Control Dialog Box, which 
displays the component controls in a more conventional user interface. 

There are eleven Component Object categories, with some categories providing several component variations.  Each 
component type will have a unique Control Dialog Box.  For more information on Control Dialog Boxes for specific 
components, select the desired category from the list below. 

 see Input Output 

 see Mixers 

 see Equalizers 

 see Filters 

 see Crossovers 

 see Dynamics 

 see Routers 

 see Delays 

 see Controls 

 see Meters 

 see Generators 

 see Diagnostics 
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Customizing Component Objects 

Component Objects can be customized in several ways.  First, when using the Object Toolbar to place components 
into the Layout, certain components will present the user with a pop-up window of configuration options.  Several pre-
defined configuration (input/output) options may be available for the component, as well as a ’custom’ selection that 
allows the user to more specifically configure the component.  Some components (such as Auto Mixers) will also 
allow activation of additional functions (such as Logic Inputs & Direct Outputs).  Also, multiple channels of Level 
Control may also be ’ganged’ together onto a single fader. 

Actual component settings can be customized through Control Dialog Boxes (see Component Object Properties).  
Control Dialog Boxes for certain Combiners, Dynamics, Controls, & Meters components can be minimized to create 
customized control surfaces (room combiners, meters, level controls, mute buttons, & preset buttons).  These control 
surfaces can then be made user accessable only on specific Layers and with specific Passwords.  (See Software User 
Interface.) 

Individual or multiple Component Objects can be customized, connected, and then saved as new Component Objects 
in the Processing Library.  This can be done by selecting the desired object(s) in the Layout, then pressing ALT and 
dragging the object(s) into an appropriate category in the Processing Library.  ALT can also be used to drag object(s) 
between design (.DAP) files, and to copy objects within the same Layout.  Right-clicking over objects (to Copy) and 
then right-clicking over a Processing Library category (to Paste), can also be used. 

Right-clicking over the Processing Library will also allow new category files (.APL) to be created, for quick access to 
specialized or often-used components.  Existing category files (.APL) can be closed, to customize the Processing 
Library.  All available category files (.APL) can be viewed and opened from the Processing Library Menu and from 
the Open dialog box. 

 

Object and Layout Text 

The size and appearance of both text and objects can be customized.  Special Text Objects can be placed into the 
Layout using the Text cursor on the Object Toolbar.  When selected, Component & Text Objects display handles 
which can be dragged for re-sizing.  Right-clicking over an object provides a pop-up menu which includes the Edit 
Text option.  Edit Text can also be accessed for a selected object by simply pressing the Enter key.  Text (and object) 
appearance can be customized using the associated tools on the Format Toolbar. 
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System Compiling Considerations 

Once a system design is created (components placed & connected), the system can be compiled by selecting Compile 
from either the File Menu or the Standard Toolbar.  Compile provides system design analysis and calculates DSP 
processing requirements.  Compile also makes initial determinations of quantity/type of Audia(TM) devices needed, 
CobraNet(TM) channel assignments, allocation of DSP resources, and I/O channel number assignments.  In addition, 
Compile will provide indication of system design errors. 

Although Compile is an automatic process, certain settings can be pre-determined to help guide this process.  DSP 
blocks (components) can be Allocated To Unit, which assigns them to a particular Audia device.  This can be useful 
either to dedicate particular audio functions to specific physical locations, or to reduce the number of CobraNet 
channels being transmitted between Audia devices (reduces propagation delay). 

Propagation Delay (also known as Latency) is an inherent time delay of the audio signals, which increases with the 
amount of DSP processing and CobraNet routing applied.  Each CobraNet ’hop’ (one-way transmission) produces 
5.13mS delay.  Therefore, system outputs can have different amounts of propagation delay.  Compile determines 
worst-case propagation delay for a system, and applies Delay Equalization to syncronize all audio outputs.  In 
applications where audio output syncronization is not important (audibly isolated areas), then Delay Equalization may 
be disabled on individual Input Output components (DSP blocks) or system wide.  See Object Property Sheet and 
Compile Options. 

Compile also attempts to ’group’ simple DSP blocks together, reducing the number of DSP blocks to be allocated to 
the available Audia devices.  Allocated To Gang can be used to ’gang’ specific components (DSP blocks) into the 
same group and, therefore, the same device. 

Compile will automatically add appropriate Audia devices to the system, based upon Input & Output needs of the 
design.  However, this Auto Device Add function may be defeated, and Audia devices may be added manually, 
using the Equipment Table.  Also, I/O Preference can be changed, to force Compile to use a specific Audia device 
(Input/Output configuration). 

For visual aids in determining DSP block allocations, see Display Options.  A system design file must be compiled 
before it can be downloaded to Audia devices (see Send Configuration). 

Compile results may be reviewed at any time (see Tools Menu > Layout Compile Results). 

Example of Compile results for a simple system 

   

 see a list of possible Compile Error Messages 
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Channel Number Assignments 

 

Release Notes for Audia version 1.2 

The assignment of channel numbers to Audio Input and Output blocks has been modified. It is still the exclusive 
function of the compiler to make channel number assignments, but now the user can influence the way the compiler 
does this. 

Here is the suggested procedure for assignment of  channel numbers to I/O blocks. It is assumed that all blocks are 
assigned to the same Audia unit. If the system contains multiple units, the following procedure should be performed 
several times. 

As always, the compiler does not modify the existing channel assignments if the I/O block has a fixed allocation to an 
Audia unit. Therefore, in order to reassign the channel numbers in the desired way, it is necessary to unassign them first. 
To do this, select all I/O blocks for the unit in question and open the Property Sheet. Select the "DSP Attributes 1" tab 
and change the value in the "Allocated To Unit" field to 0 (you will have to set the flag "Fixed In Unit" to "No" first). 
This will reset the channel number assignments in the selected I/O blocks. Then change the  "Allocated To Unit" field 
back to its original value and set the flag "Fixed In Unit" back to "Yes". Unselect all DSP blocks by left clicking in the 
view. 

The next step is to indicate to the compiler the desired order in which you want the channel numbers assigned. Repeat 
the following sequence for each I/O block in the order you want the channel numbers assigned, i.e., I/O block with the 
lowest channel number(s) first, I/O block with the highest channel number(s) last: 

- Select the block by left-clicking on it 

- Bring it to front by hitting CTRL+F. 

Now recompile, and the channel numbers will be assigned in the order you selected the blocks. 

Note: the Input and Output blocks for a given single unit can be processed at the same time. 
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Compile Error Messages 
 

Construction of the Topology Map 

 

Message:   Unintended use of Combiner block detected. 

Explanation:   A source, other than an Auto Mixer Main Output, is connected to a 

  Mix-Minus Combiner input.  Mix-Minus Combiners allow Auto Mixers to share 

  control data only, and do not support audio input or output. 

 

Message:   The main output of an Auto Mixer is connected to more than one 

  Combiner block. 

Explanation:   The main output of an Auto Mixer can be connected to only a single 

  Combiner input (Mix-Minus or Room).  Otherwise, Auto Mixer control 

  data might be shared with multiple groups of combined mixers, causing 

  convoluted behavior. 

 

Validation of the Topology Map 

 

Messages: Failed to load ’DSPNodeSpecs.dll’. 

  Could not locate the function ’DSPRes’ within the 

  ’DSPNodeSpecs.dll’.  

Explanation: Indicates a software or software installation problem. 

 

Message:   Empty layout ! 

Explanation:   No objects have been placed in the layout. 

 

Messages:   There are no audio sources or destinations. 

  There are no audio sources. 

  There are no audio destinations. 

Explanation: No audio input/output objects have been placed (or connected) in the 

  layout. 
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Messages: Some DSP blocks do not have inputs. Ignore them ? 

  Some DSP blocks do not have outputs. Ignore them ? 

  Some DSP blocks are not connected to any audio output. Ignore 

  them ? 

Explanation: These messages appear only if the flag ’Prompt To Stop Compilation 

  On Warnings’ is set under Tools>Options>Compile.  If the choice to 

  ’Ignore’ is selected, then the warning "Ignored ’...’ (object code ’...’) at 

  [__, __]" will be  listed in the compile results.  If the ’Prompt To Stop 

  Compilation On  Warnings’ flag is not set, then compilation proceeds 

  and ’Ignores’ automatically. 

 

Messages: The algorithm for the’__’ block (object code ’__’) at [__,__] has been deprecated. 

  You should replace the existing block with a newly created one which uses the 

  most up to date algorithm. 

  You should replace the existing blocks with newly created ones which use the 

  most up to date algorithms. 

Explanation: The first warning is issued for each DSP block in the layout that is considered 

  outdated.  One of the subsequent messages will also appear, depending upon 

  whether there is only one outdated block or multiple outdated blocks detected. 

 

Message: Channel numbers have been reset in some audio I/O blocks. 

  Re-compile to update the channel number assignments. 

Explanation: Channel numbers were assigned in an input/output object, and that 

  object was assigned to a specific Audia unit by fixed alllocation. 

  Therefore, the channel numbers also became fixed.  Then the 

  Audia I/O configuration was changed in the Equipment Table. 

  Since the new I/O configuration has less input or ouput channels, 

  some channel numbers have become invalid. 

  Once reset, Compile will automatically re-assign channel numbers. 

 

Message: Nothing to compile ! 

Explanation: All objects placed in layout have been ignored. 
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Messages: Insufficient audio inputs and outputs to implement this layout. 

  Insufficient audio inputs to implement this layout. 

  Insufficient audio outputs to implement this layout. 

Explanation: The design requires more input/output channels than are available 

  from the Audia device(s) specified in the Equipment Table.  This 

  can only occur if the flag ’Auto Device Add’ is not set under 

  Tools>Options>Compile. 

 

Message: Insufficient computing power to implement this layout. 

Explanation: The design requires more DSP resources than are available 

  from the Audia device(s) specified in the Equipment Table.  This 

  can only occur if the flag ’Auto Device Add’ is not set under 

  Tools>Options>Compile. 

 

Message: Feedback loop detected. 

Explanation: The potential exists for an audio path to be indirectly looped back 

  upon itself.  This condition could be dangerous, and is not allowed. 

 

Messages: Specified Audia unit #__ is not in the Equipment Table. 

  Specified Audia unit #__ is not selected for use. 

Explanation: Some DSP blocks have been assigned as fixed allocations in a 

  specific Audia unit which is not available or selected for use. 

 

Messages: Too many audio inputs required for fixed allocations in unit #__. 

  Too many audio outputs required for fixed allocations in unit #__. 

  Unit #__ has no CobraNet communication module. 

  Too many CobraNet inputs or outputs allocated to unit #__. 

Explanation: The number of audio channels assigned as fixed allocations in a 

  specific Audia unit exceeds the capacity of that unit. 
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Messages: Insufficient DSP power for fixed allocations in unit #__: ___% of 

  capacity requested. 

Explanation: The DSP resources assigned as fixed allocations in a specific 

  Audia unit exceed the capacity of that unit. 

 

Message: Gang #__ requires too many resources. 

Explanation: The component objects allocated to the specified gang require more 

  resources (audio channels, CobraNet channels, and/or DSP power) 

  than is available from any current Audia unit. 

 

Allocation of DSP blocks to Audia Devices 

 

Message: Too many combinations. Try to reduce the number of groups by 

  combining DSP blocks. 

Explanation: The possibilities are too numerous to determine a solution within 

  a reasonable period of time.  Reduce the number of groups by 

  ganging components together or giving them fixed allocations. 

 

Message: Group #__ has too many connections to be placed into an Audia 

  unit. 

Explanation: The specified group requires so many links to other groups that it 

  would exceed the ’bundle’ limitations of CobraNet.  Normally, the 

  number of CobraNet connections could be reduced by combining 

  the specified group with some other group(s).  However, in this case, 

  it would require more resources than available in a single Audia unit. 

  Attempt to produce more compact groups, with fewer connections, 

  using fixed allocations and/or ganging.  This can also happen if 

  CobraNet I/O blocks have been placed into a non-CobraNet unit. 
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Message: Could not place group #__ anywhere. There might be a contention on 

   group(s)____. 

Explanation: The specified group requires so many links to other groups that it 

  would exceed the ’bundle’ limitations of CobraNet.  Normally, the 

  number of CobraNet connections could be reduced by combining 

  the specified group with some other group(s).  However, in this case, 

  the number of CobraNet connections cannot be reduced sufficiently. 

 

Message: Could not find a solution. 

Explanation: Compile was unable to place the produced groups into available 

  Audia units.  Attempt to use fixed allocations and/or ganging to 

  change the formation of groups.. 

   

Message: Although the total DSP power is sufficient, the compiler cannot place 

  the resulting groups into the Audia units in the Equipment Table. 

  More units would have to be added. 

Explanation: Compile was not able to distribute the produced groups among the 

  available Audia units.  This can only occur if the flag ’Auto Device 

  Add’ is not set under Tools>Options>Compile.  Attempt to produce 

  smaller groups using fixed allocations and/or ganging.  If 

  unsuccessful, set ’Auto Device Add’ so Compile will automatically 

  add necessary Audia units to the Equipment Table.  Audia units can 

  also be added manually.  

 

Message: Total maximal duration of delays exceeded in the unit #_. 

Explanation: The number of delay blocks, and their combined delay ranges, 

  exceeds the maximum capability of this unit.  Currently, any single 

  Audia unit can provide a maximum of 45 seconds of delay blocks. 

  Matrix Mixers with Delay also contribute to this total, consuming 

  1 second per input channel.  
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Allocation of DSP blocks to DSPs 

 

Message: Allocating blocks to DSPs...failed to set up a feasible DSP task 

  schedule in the unit #__.  You should move some processing blocks 

  from this unit into another unit using fixed allocations. 

Explanation: Although the total DSP power in the Audia unit is sufficient, compile 

  was not able to distribute the component objects among the 

  available DSPs.  When the DSP load approaches 100%, it becomes 

  crucial that the objects be distributed more uniformly.  Try moving 

  certain objects to another unit (using fixed allocations), or replace 

  them with a comparable set of smaller objects (within the same unit). 

 

Assigning control blocks to Audia units 

 

Message:   Some unconnected control blocks have been ignored. 

Explanation:   Control blocks with no connections have been excluded from the 

  system.  Only Logic Gate and Remote Preset Button blocks can be 

  ignored.  When connected to the system, control dialogs for ignored 

  blocks cannot be accessed. 

 

Message:   Feedback detected in the control network. 

Explanation:   The potential exists for a control path to be indirectly looped back 

  upon itself.  This condition could be dangerous, and is not allowed. 

 

Message:   Unit #__ has too many control connections. 

Explanation:   Although quite large, there is a limit to the quantity of control 

  connections within a single unit.  Connections include both internal 

  (source and destination within same unit) and external links (source 

  or destination within this unit).  Try moving certain control objects to 

  another unit (using fixed allocations), 
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Setting up the Audia units after a successful compilation 

 

Message: Could not assign audio I/O channels in the unit # __. 

Explanation: Indicates a software problem.  Please contact Biamp Systems. 

Messages: Available range of Instance IDs is nearly exhausted. 

  Range of Instance IDs has been exhausted. 

Explanation: The total number of Instance IDs, as assigned to component and 

  line objects, is limited to 65,535.  When component objects are 

  removed from a design, their Instance IDs are not automatically 

  re-assigned to new component objects.  Therefore, the messages 

  above indicate that a significant number of Instance IDs has been 

  wasted.  Set ’Reassign Instance IDs’ under Tools>Options>Compile 

  and re-compile to recover wasted Instance IDs.  CAUTION:  This 

  will change most component Instance IDs, and will render existing 

  external control command scripts useless.  Once Instance IDs have 

  been recovered, turn off ’Reassign Instance IDs’ to avoid further 

  re-assignments. 
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System Network Considerations 
The computer must have a 10/100 BaseT network card (NIC) installed.  When connecting directly to a single 
Audia(TM) unit, a ’cross-over’ CAT5 cable is used.  When connecting to a network (or system) of multiple Audia 
units, a ’straight-through’ CAT5 cable is used (via an Ethernet switch).  The Ethernet switch (not ’hub’) must be 10/100 
BaseT compatible, with sufficient ports for both Ethernet and CobraNet connections to each Audia unit (multiple 
switches may be used).  If the Ethernet switch is ’managed’, be careful to assign all CobraNet connections to 100 
BaseT, and all Ethernet connections to 10 BaseT.  These connections also use ’straight-through’ CAT5 cables. 

Ethernet and CobraNet both have a cable length limitation of 100 meters, between the Ethernet switch and an Audia 
device.  However, fiber-optic cable may be used to extend this distance limitation to 2 km.  Fiber-optic cable can be 
used with switches that have fiber-optic ports, or media converters can be used to interface fiber-optic cable with 
standard RJ-45 ports.  

Due to network delay, CobraNet has a limitation of seven (7) ’hops’ (one-way transmissions) within a network.  
Additionally, because CobraNet transmits (32) channels of digital audio on (4) ’bundles’ of (8) channels, each Audia 
device can transmit digital audio to no more than (4) other Audia devices within a network.  The same is true for 
receiving digital audio over CobraNet. 

The computer must be assigned an IP address (under Network Card Settings>Properties).  Most computers set TCP/IP 
address automatically, but Audia devices require manual assignment.  IP addresses can be assigned as 192.168.1.X 
(where range of X = 1~254).  Each Audia device must also be assigned a unique IP address (see Device 
Maintenance).      

Many system designs require only a single Audia device.  These would be systems where the number of 
inputs/outputs, and the amount of DSP processing, does not exceed that of a standard configuration (see Hardware 
Overview).  When a single unit is used, network considerations are simplified.  A ’non-CobraNet’ unit may be used, 
and no Ethernet switch is required.  Therefore, all CobraNet connections, and most Ethernet connections go away, as 
well.  The only Ethernet connection is that between the computer and the Audia device (’cross-over’ CAT5 cable).  A 
’cross-over’ cable is included with each Audia device.  
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Applications 
 

Example of a 6 room combining system controlled by logic inputs 

 

This example shows 2 Audia 12x4CM units used in a 6 room combining system.  Each room has 4 inputs that route 
into an Auto Mixer.  The outputs of each Auto Mixer route into a Room Combiner.  The Room Combiner allows one 
to create a graphical representation of the room geometry and any moveable barriers between rooms.  When rooms are 
combined with the Room Combiner, audio as well as Auto Mixer ATS and NOM data are shared.  This example 
shows the Room Combiner block controlled by external logic inputs through the Audia Logic Box.  Each moveable 
barrier within the Room Combiner has a logic input.  By opening and closing external switches wired to these logic 
inputs, rooms are combined or separated automatically within the Room Combiner block. 
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Example of a system using Select 8 and Volume 8 remote control devices 

 

This example demonstrates the use of external remote controls to recall presets and adjust volume within an Audia 
system.  The Select 8 block is wired to a Remote Preset Button block where 8 presets have been assigned.  One may 
simply select the appropriate preset on the external Select 8 device and activate it with the press of the button.  The 
Volume 8 block has been programmed to control an 8 channel Level Control block.  One can select the appropriate 
channel on the external Volume 8 device and adjust the level by turning the rotary encoder. 
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Example of a stereo sound system with delay and subwoofer. 

 

This example demonstrates an 8x8 Audia unit utilized in a live sound application.  8 line inputs feed an 8x4 Standard 
Mixer.  Audio is routed from the mixer to both left and right channels of a 3-Way Crossover.  A five-band Parametric 
Equalizer is provided at each Crossover output channel for precise driver equalization.  A mono Delay line output is 
provided for delayed speakers, as well as a Low Pass Filter output for a mono subwoofer.  A Level Control for each 
output provides precision volume control.  This example also includes a Comp/Limiter on each channel and RMS 
Meters on both the input and the output of the system. 
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Example of a 3 unit audio distribution/routing system. 

 

This example demonstrates three 8x8 Audia units used in a large audio distribution and routing system.  Such a system 
could be used for paging or background music distribution in a very large hotel or convention center.  Each of the 
three units is connected via CobraNet using Cat5 cable with a 10/100 Base-T Ethernet switch.  Note: dotted blue lines 
represent CobraNet connections.  In this example we have a total of 24 audio inputs, each with its own Level Control.  
The 24x24 Matrix Mixer allows audio from any source to be routed to any combination of outputs.  A Comp/Limiter 
is included on each output channel in this example. 
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Hardware 
 

Hardware Overview 

Audia(TM) is currently available in three I/O configurations:   8-in & 8-out (8x8);  12-in & 4-out (12x4);  4-in & 12-out 
(4x12).  Additional input/output configurations will become available in the future.  Inputs & outputs are analog, with 
internal 24-bit A/D & D/A converters, operating at a sample rate of 48kHz.  All internal processing is digital (DSP). 
 

  

  

  
 

Inputs & Outputs:  Inputs & outputs are provided on balanced plug-in barrier-strip connectors.  For unbalanced input, 
wire high to (+) and ground to both ( ) & (-).  For unbalanced output, wire high to (+) and ground to ( ), leaving (-) 
un-connected.  Inputs can be individually programmed to accept either microphone or line level signals.  A 12x4 
configuration allows Inputs 11 & 12 to be set for stereo input summing.  Outputs normally provide line level signal 
only.  However, a 4x12 configuration allows Outputs 1~4 to be set for mic level. 
 

Ethernet:  All Audia units use Ethernet, both for system programming & control.  Programming is accomplished using 
the Audia software provided with each unit.  Audia software is for PC computers, with Windows NT 4.0/2000/XP 
operating system required.  The PC computer must have a network card installed, which supports 10/100BaseT 
Ethernet.  A 10/100Base-T Ethernet switch (not hub) is required when networking multiple units.  Ethernet utilizes 
standard CAT-5 cabling, which has a specified maximum length of 100 meters.  However, Ethernet switches which 
provide fiber-optic interface can be used to extend the physical distance between units within a network. 
 

Remote Control Bus:  The Remote Control Bus provides the connection for Volume 8, Select 8, Volume/Select 8, and 
Logic Box external control devices.  (See Control Bus for more information). 
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CobraNet(TM):  All Audia configurations are available without CobraNet (for stand-alone applications) or with 
CobraNet (for networking applications).  Individual or multiple ’non-CobraNet’ Audia units can be used within a 
system, but without the ability to share digital audio or DSP resources.  However, Audia units with CobraNet can 
automatically share digital audio & DSP resources within a system, allowing seamless networking.  The Audia 
CobraNet interface supports 64 channels of digital audio (32-in & 32-out), over Fast Ethernet, and is compatible with 
other CobraNet compliant devices.  Therefore, Audia can also be networked with CobraNet products from other 
manufacturers, expanding the system configuration capabilities.  A 10/100Base-T Ethernet switch (not hub) is required 
when networking multiple units.  CobraNet utilizes standard CAT-5 cabling, which has a specified maximum length of 
100 meters.  However, Ethernet switches which provide fiber-optic interface can be used to extend the physical distance 
between units within a network.  The primary and secondary CobraNet ports are redundant.   
 

Serial Control Port:  After initial programming & configuration, Audia systems may be controlled by RS-232 or 
Telnet communication from third-party control systems such as AMX® or Crestron®, using the Serial Control Port. 
 

Power Entrance:  The Power Entrance provides for connection of the appropriate power cord (included with unit).  An 
internal universal switching power supply accepts 100~240VAC @ 50/60Hz, with a maximum power consumption of 
115 Watts. 
 
 
 
 

  
 

Front Panel Indicators:  The Front Panel Indicators (I/O, Com, & Status) are 2-color LEDs. 

The following table lists their behaviors: 
 

I/O LED:  green 

Com LED:  green 

Status LED:  green 

Normal operating state.  Application framework successfully executed.  Configuration was successful (if applicable).  
Device is in a stable state awaiting commands. 

 

I/0 LED:  red 

CM-1 error 

Daughterboard error 

 



 88 

Com LED:  red 

Serial port error 

Ethernet error 

CAN  bus error 

No IP address defined (cleared by setting an IP address) 

 

Status LED:  red 

Configuration error 

Last configuration unsuccessful (cleared by ’reset/initializing’ the device) 

Operating system resource error 

File system error 

DSP error 

 

All LEDs blinking 

Operating system is not executing.  Device must be power-cycled. 

 

Status LED blinking 

The firmware has attempted to perform an illegal operation.  Device must be power-cycled. 
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System Connections 

For wiring information on specific connectors, see Hardware Overview, System Network Considerations, and Control 
Bus. 

 

Example of connections for a system with 24 inputs and 8 outputs 
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System Control 
 

Software User Interface 

Once a system design is compiled and downloaded into Audia devices, the system can be controlled in real-time the 
via the Audia software.  The extent of control can be limited with different password levels. 

In addition, Control Dialog Boxes for certain Combiners, Dynamics, Controls, & Meters components can be 
minimized to create customized control surfaces (room combiners, meters, level controls, mute buttons, & preset 
buttons).  These control surfaces can then be made accessable to the User, only with a specific Password. 

These control surfaces remain functional, even if other component settings are made inaccessable to the User (via 
Password Level).  The control surfaces can also remain visible, even if the components they represent are made 
invisible (via Layer View).  Therefore, a custom User control surface can be created in the Layout, with User access 
allowed, but with all other system settings inaccessable (and hidden).  The size & shape of the Layout may be 
changed, and Toolbars hidden, to customize the appearance of the User control screen. 

 

Example of simple 8x8 system user control surface      
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Remote Control Bus 

Remote Control Bus provides the connection for Volume 8, Select 8, Volume/Select 8, and Logic Box 
external control devices.   

 

Each Audia device can support any combination of the controls mentioned above.  Up to 32 controls may 
be connected to each Audia device, on a daisy-chain ’network’, with a maximum cable length of 1000 feet 
(300 meters).  Controls are wired in parallel (pin-for-pin), using 5-conductor data grade cable (95~120 
ohms nominal impedance; 16 pF/ft. max. capacitance;  65% min. velocity of prop.). 

Recommended cable:  Gepco UNC220 or equivalent 

(use data pair for Hi & Lo;  use power pair for + & -). 

 

The ’network’ requires termination at each ’end’ for proper operation.  All controls (and Audia) include 
either a termination switch or jumper strap.  These terminations should be disabled (switch out or jumper 
removed) on all devices except those at the two extreme ends of the network. (See wiring diagram below). 

 

A control network may be wired with the Audia device at one end, and a control device at the other end, 
creating one continuous run.  In this case, the Audia device would have the ’term’ switch engaged (in), 
and the control device at the other end of the network would have the ’term’ switch engaged (in) or jumper 
installed.  All other controls, between the Audia device and the last control, would have their ’term’ 
switches released (out) or jumpers removed. 

 

If a control network needs to service two areas which are in opposite directions from the Audia device, a 
network with two separate runs can be created.  This type network actually remains as a single run, but is 
configured with the Audia device in the middle.  Therefore, only the controls at the two extreme ends of 
the network would have their ’term’ switches engaged (in) or jumpers installed.  All other controls 
(including the Audia device), between the two end controls, would have their ’term’ switches released (out) 
or jumpers removed.  (See network diagrams on next page.) 
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Third-Party Control 
After initial programming & configuration, Audia systems may be controlled by RS-232 communication from third-
party control systems such as AMX® or Crestron®, using the Serial Control Port.  See RS-232 and Telnet Protocol. 

 

RS-232 and Telnet Protocol 
Overview 

Audia can be controlled via customized control dialogs in the Audia software, or via third-party controllers using RS-
232 or Telnet. 

For RS-232 or Ethernet (Telnet) control of Audia, Biamp created ATP (Audia Text Protocol). This simply means that 
Audia will accept strings of ASCII characters to control and read settings of gain, mute, logic state, frequency, audio 
levels, and other parameters of DSP blocks that exist in Audia products. 

ATP strings can be sent via third-party controllers using RS-232 or Telnet via TCP/IP.  A line feed needs to be sent after 
each command string sent.  (RS-232 Control) (Telnet Control) 

The ATP string is structured in the following order: Command  Device Number  Attribute  Instance ID Number  Index1  
Index2  Value  <LF> 

ATP strings require a space between each parameter; the last character in the string needs to be a line feed <LF>. 

For each control string a few components will need to be derived from the Audia software; Device Number, Instance ID 
Number, and Index.  Command and Attribute are derived from this document.   In a SET command, Value is used to 
specify what the DSP block is to be set to.  In an increment or decrement (INC or DEC) command Value is used to 
specify how much the DSP block is to be changed by.   

**Note** Audia software will assign an Instance ID Number to each DSP block on the initial Compile of the system.  
Subsequent Compiles will not change the Instance ID Numbers unless the "Reassign Instance IDs" check box is 
selected under Compile Options. 

Example: A string to control a fader might look like this: 

SET 1 FDRLVL 2 1 9 <LF>.  The individual components for this string are: 

  

Notice that Index2 is not used since there is nothing entered in this parameter. 

 

Example: A string to mute a standard mixer output might look like this: 

SET 3 SMMUTEOUT 5 5 1 <LF>  The individual components for this string are: 

  

Notice that Index1 is not used since there is nothing entered in this parameter. 
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Example: A string to turn up a cross point on a matrix mixer might look like this: 

INC 2 MMLVLXP 4 3 2 1 <LF>  The individual components for this string are: 

  

In this example Index1 and Index2 are both used; together they specify which cross point is to be changed. 

 

 

 

RS-232 Control 
The RS-232 port on the back of an Audia unit is set to a default baud rate of 38400, 8 data bits, no parity, 1 stop bit, and 
no flow control. (38400:8:None:1).  If multiple Audia units are connected together in a system then only one RS-232 
port needs to be connected to a third-party control system; communication data is shared via Ethernet through a switch.  

When controlling multiple Audia units that are not part of the same DAP file, each Audia unit will need to be addressed 
via its own RS-232 port from a control system or PC.  Audia units cannot be linked together via RS-232, like some 
other BIAMP Advantage products can.  

 (The RS-232 baud rate can be set to 9600, 19200, or 38400 – default is 38400) 

A straight through PC Serial Cable is used to communicate from an RS-232 port on a third-party controller (or PC*) to 
the RS-232 port located on the back of an Audia unit. 

  

 (* A PC can be used with a terminal emulator program, such as HyperTerminal etc, to send/receive ATP 
Strings…Audia software must be connected via Ethernet in order to communicate.) 

 

 

 

 

Telnet Control 
Audia can be controlled using Telnet via TCP/IP.  The same command strings that are used via RS-232 are used for 
Telnet as well.   

When controlling multiple Audia units that are not a part of the same DAP file, each Audia unit will need to be 
addressed via its own Telnet session from a control system or PC. 
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Command 

SET – Tells Audia that a DSP attribute is to be set to a specific value – may contain negative number and/or decimal 
points 

GET - Tells Audia that a DSP attribute is to be read - Response may contain a decimal point and/or a negative number. 

INC - Tells Audia that a DSP attribute is to be incremented by a specific amount 

DEC- Tells Audia that a DSP attribute is to be decremented by a specific amount 

RECALL – Tells Audia that a preset is to be recalled. 

 

SETL and GETL can be used if negative numbers and/or decimals are not supported by a control system. 

 

SETL – Tells Audia that a DSP attribute is to be set to a specific value, no decimal places or negative numbers – To 
convert a dB number: add 100 to the desired level and then multiply by 10.  

 

Example:  To set a level to –60.5dB, add 100 (-60.5 +100 = 39.5).  Then multiply by 10 (39.5 X 10 = 395).  Instead of 
Value being –60.5, Value after this SETL command will equal 395. 

 

GETL - Tells Audia that a DSP attribute is to be read without negative numbers or decimals.  To convert this number to 
dB: divide the number by 10, then subtract 100. 

 

Example:  With a returned GETL response of 405, divide by 10 (405 / 10 = 40.5), then subtract 100  (40.5 – 100 = -
59.5dB) 

 

For your reference, the SETL/GETL table shows .5dB increments converted into the SETL/GETL format. 

 

Some Attribute do not support all commands.  The Attribute section defines which commands support SET/SETL, 
GET/GETL, INC, or DEC functions.  RECALL is only used on preset commands. 

 

*When GET or GETL is used, a Value will not need to be specified since GET/GETL is a request command.  A Value 
must be specified in order for strings with SET/SETL, INC, DEC, and RECALL to work. 
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Table of SETL and GETL levels converted from floating-point numbers. 
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Device Number 

An Audia Device Number represents the physical Audia box’s defined address.  The Audia software automatically sets 
this number when a system is Compiled and loaded.  

The Device number that a DSP block has been assigned to can be determined in two ways: 

 

First Way: 

1) Right click on the DSP block and select ‘Properties’. 

2) Click on DSP 1 attributes tab and scroll down.  The device that the block is assigned to will be displayed in the 
‘Allocated To Unit’ field. 

*Note:  Each DSP block can be assigned to a device by changing ‘Fixed In to Unit" to ‘Yes’ (this is defaulted to no). 

  

 

Second Way: 

1) In the Display Options tab select "Display Device Assignment in DSP Block info field". 

This will display the device that each DSP block is assigned to on the main screen. 

  

 

Third Way: 

 1) While connected an Audia’s RS-232 port, type the string; GET 0 DEVID   Audia will return the 
Device Number of the unit you are connected to. 
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Attribute 

The Attribute defines the portion of the DSP block to be controlled (fader level, crosspoint mute etc).  The following 
tables show whether each ATP Attribute supports SET/SETL, GET/GETL, INC, and DEC Commands, as well as the 
Value range that the Attribute will accept.  Index1/Index2 determines whether Index1, Index2 or BOTH are needed for 
a ATP String to be complete. 

ATP Strings can address: (click on the links to view the tables in each topic) 

Input/Output Blocks  

Mixer Blocks  

Equalizer Blocks  

Filter Blocks  

Crossover Blocks  

Dynamics Blocks  

Router Blocks  

Delay Blocks  

Control Blocks  

Meter Blocks  

Generator Blocks  

 

 

Input/Output Blocks 

  

* Can contain a decimal number.  

Example: In the command: SET 1 INPLVL 6 3 –10<LF>  

We are telling Audia device 1 to set an input fader, Instance ID 6, input 3 (index1), to –10dB.  (We set channel 3 input 
level of instance 6 to –10dB) 
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* Can contain a decimal number. 

Example: In the command:  SET 2 OUTMUTE 3 4 1<LF>   

We are telling Audia device 2 to set the output mute Instance ID 3, output 4 (index1) to on. (We muted the 4th output of 
Instance ID 3 of an Audia)   

  

   

* Can contain a decimal number. 
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Mixer Blocks 

  

* Can contain a decimal number. 

Example: In the command: SET 1 AMMUTEXP 3 1 0<LF> 

We are telling Audia device 1 to set the automixer’s crosspoint (row 1, column 1) on instance ID 3 to off. 

Note: for attributes with 2 Index fields, Index1 is the row, and Index2 is the column.  

 

  

* Can contain a decimal number. 

Note: for attributes with 2 Index fields, Index 1 is the row, and Index2 is the column. 
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* Can contain a decimal number. 

Note: for attributes with 2 Index fields, Index1 is the row, and Index2 is the column. 

 

  

* Can contain a decimal number. 

Note: For wall state, Index1 represents the wall being opened or closed.  

 

  

Note: Index1 is the input number being addressed.  Index2 is the group number; this is represented by a letter in the 
software, but addressed as a number in ATP commands. 

(Example: A=1, B=2, C=3….)  
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Equalizer Blocks 

  

* Can contain a decimal number.  

The Index field represents the filter to be controlled.  EQ filter farthest to the left is #1, next one is #2 and so forth.  
Upper left hand area of Graphic EQ dialog screen displays, which numbered filter, is being adjusted, use this number 
as the Index1 for Graphic EQ strings. 

Example: In the string SET 2 GEQBYPALL 9 1 <LF>  

We are telling Audia to bypass all bands on Graphic EQ Instance ID 9. 

 

  

* Can contain a decimal number. 

Upper left hand area of Parametric EQ dialog screen displays, which numbered filter, is being adjusted, use this 
number as the Index1 for Parametric EQ strings. 

Example: In the string INC 1 PEQLVLBND 11 3 2<LF> 

We are telling Audia to increment the second parametric EQ filter on Instance ID 11 by 2dB. 
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Filter Blocks 

  

  

  

  

* Can contain a decimal number.  

Example: SET 1 HSFTGAIN 100 –10<LF> 

We are telling Audia to set the High Shelf filter gain on instance ID 100 to –10dB. 
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Crossover Blocks 

  

  

  

* Can contain a decimal number. 

Example: GET 2 XOVR3FC 40 1 <LF> 

We are asking Audia to tell us the 3-way crossover low-pass cutoff frequency on instance ID 40. 

 
2-way crossover: 
 

Index1= 1 is the low-pass cutoff frequency 
Index1= 2 is the high-pass cutoff frequency 

 
3-Way crossover: 
 
 Index1 = 1 is low-pass cutoff frequency 
 Index1 = 2 is the lower slope of the mid cutoff frequency 
 Index1 = 3 is the higher slope of the mid cutoff frequency 
 Index1 = 4 is the high-pass cutoff frequency 
 
4-way crossover: 
 
 Index1 = 1 is the low-pass cutoff frequency 
 Index1 = 2 is the lower slope of the low-mid cutoff frequency 
 Index1 = 3 is the higher slope of the low-mid cutoff frequency 
 Index1 = 4 is the lower slope of the high-mid cutoff frequency 
 Index1 = 5 is the higher slope of the high-mid cutoff frequency 
 Index1 = 6 is the high-pass cutoff frequency 
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Dynamics Blocks 

  

  

  

* Can contain a decimal number.  

 

  

Example: SET 3 CLIMBYP 55 0<LF> 

We are telling Audia to set the Comp/Limiter on instance ID 55 to active. 
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Router Blocks 

  

Example: SET 1 RTRMUTEXP 98 4 5 0<LF>  

Note: for attributes with 2 Index fields, Index1 is the row, and Index2 is the column. 

 

 

Delay Blocks 

No Attributes are specified at this time 

 

 

Control Blocks 

  

* Can contain a decimal number. 

 

  

Note: Instead of SET/SETL, GET/GETL, INC, or DEC; the preset attribute uses RECALL as the Command.  Preset 
numbers begin at 1001, regardless of preset name (the first preset defined is 1001, the next 1002, and so forth).   

Example: in the string: RECALL 2 PRESET 1001<LF> 

We are telling Audia to recall the first preset on an Audia system.  Since presets apply to entire systems, or DAP files, 
the Device Number will always be 1 for Preset strings. 
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Meter Blocks 

  

* Can contain a decimal number. 

Example: GET 1 RMSMTRLVL 48 1 <LF> 

We are asking Audia the RMS Meter 1 level on instance ID 48. 

 

Generator Blocks 

No Attributes are specified at this time 

 

 

 

Instance ID Number 

Audia uses an instance ID number to specify the exact DSP block to be controlled.  Right click on the DSP block and 
select "Properties", the instance number can be found the DSP Attributes 1 tab. 

  

**Note** From the factory the Audia software will assign an instance number to each DSP block on the initial Compile 
of the system.  Subsequent compiles will not change the Instance ID Numbers unless the "re-assign Instance IDs" check 
box is selected under Compile Options. 

If one or more DSP blocks are disconnected from the audio path (when connections are not made to at least one input or 
output) the Instance IDs will be unassigned.  New Instance ID(s) will be reassigned once the DSP block(s) are properly 
connected again. 
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Index 

Index refers to inputs, outputs, or cross points of an Attribute.  Some Attributes will need an Index1 (Input or Row) 
and/or an Index2 (output or Column).  The tables in the Attribute section will define which, if any, indexes are required 
for the string. 

  
  

Example: INC 1 AMLVLIN 4 1 1<LF> 

In an Automatic mixer on device 1 we are increasing the level of input 1 on instance ID 4 by 1dB.  Index1 is used to 
represent the input number. 

Example: DEC 2 AMLVLOUT 6 1 2<LF> 

In an Automatic mixer on device 2 we are decreasing the level of output 1 on instance ID 6 by 2dB.  Index2 is used to 
represent the output number. 

Example: SET 1 MMLXP 5 1 2 –5<LF> 

In a matrix mixer on device 1 we are setting cross point 1:2 (row 1, column 2) level to –5dB on instance ID 5. 

Note for commands with 2 Index fields, Index1 is the row, and Index2 is the column. 
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Value 

Value determines what a DSP block is being set to, incremented by, or decremented by.  The Attribute section will 
define which type of value the string will need in order to execute the ATP string. 

Example: INC 1 AMLVLIN 4 1 1<LF> 

In an Automatic mixer input level string, the Value equal to 1 states that the fader is to be incremented by 1 dB.   

Example: SET 2 MMLVLIN 5 2 –100<LF> 

In a matrix mixer input level string, the value is set to –100dB. 

Example: RECALL 1 PRESET 1004<LF> 

For a preset recall we are telling device 2 to recall the fourth preset. 

*When GET is used, a Value will not need to be specified since GET is a request command.  A Value must be set in 
order for SET, INC, DEC, and RECALL command strings to work. 

Example: GET 4 MMLVLOUT 5 <LF> 

We are asking the level of a matrix mixer's output.  There is no Value required for this string. 

 

 

Responses 

When a successful SET, SETL, INC, DEC, or RECALL command is sent to an Audia device via RS-232 or TCP/IP, 
Audia will respond with: ‘+OK’ followed by a carriage return and line feed. 

Example:  Sending the string: SET 2 AMLVLIN 4 2 1< LF> will result in an: +OK<CR><LF> response.  

 

A successful GET or GETL command will result in a numerical response to the command string followed by 
<CR><LF>. 

 

The response from a ATP string with a GET command can contain negative numbers, and/or decimal points, depending 
on type of Attribute addressed.  If the control system does not support negative numbers or decimal places a GETL 
command may be used instead. 

 

Example: After sending the above example to an Audia device the string:  

GET 2 AMLVLIN 4 2<LF> would result in the response: 1.0000<CR><LF> this tells us that the level is currently set to 
1dB. 

 

If an incorrect command string is sent, an Audia will respond with: -ERR <CR><LF> 
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